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iLounge
Photo & ArT Galleries

Other entries in our iPod In Car series ranged from eye-catching 
and fun to subtle and sophisticated. These are some of the more 

memorable ones we received.

Photo Contest
iPod Fashion: People
Top Submissions

Our iPod Fashion contest challenged readers to create one of two 
types of photographs: a fashionable picture of at least one person 
with an iPod, or a picture of an iPod dressed up like something or 
someone. Here are some of the stunning entries we received.

iPod On The Go
Jeff Cheng, Hong Kong
Prize: Shure E500PTH Earphones
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Let the Music Play (above)
 Banja Luka, Republika Srpska

Grand Prize: Apple iPhone 8GB ($599)

CHiLL (right)
Canada

Second Prize: Apple iPhone 4GB ($499)
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iPod Girls (above)
Guillermo A. Romer, Mexico

Third Prize: $100 iTunes Gift Certificate
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Photo Contest
iPod Fashion: iPods
Top Submissions

Our initial concern over the quality of our iPod dress-up contest 
entries disappeared as increasingly impressive entries began to 
appear. The Grand Prize winner, a Marvel Comics illustrator, used 
his own amazing background and iPod art to create a highly 
memorable photo; several awesome entries lost out only for 
violating our “no use of others’ photos” rule.

iPod of Oz
 Alfredo José Richner, Puerto Rico

Second Prize: Apple iPhone 4GB ($499)

iCaptain
Mitch Breitweiser, Arkansas, US
Grand Prize: Apple iPhone 8GB ($599)
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Time for Make Up
Ahmed Shokry Batout, Egypt

Third Prize: $100 iTunes Gift Certificate
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Europe

Some Favorites From the
iPods Around the World

Photo Galleries

Now with over 4,150 photos, our iPods Around the World 
gallery continues to be a favorite destination for iLounge 
readers. We’ve gathered some of our favorite pictures from 
a few of the gallery’s top destinations - add yours today!

Leah with the iPod shuffle
Holzkirchen, Bavaria, Germany

A view of Derwentwater from 
the Summit of Cat Bells

Cumbria, England

Alps Mountains
Aosta, Italy

The Marques Tower, Chateau de Chenonceau
Loire, France
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Asia/Pacific

With Mao
Lijiang, Yunnan, China

Grooving in Thailand
Chiang Mai, Thailand

Fushimi Inari Temple
Kyoto, Japan

Mt. Ruapehu
North Island, New Zealand
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Hotel Burj al Arab
Dubai, U.A.E.

Urn Tomb
Petra, Jordan

Sahara Desert
Egypt

Female member of Mursi tribe
Southern Ethiopia

Middle East/Africa



141

galleriesThe Free iPod Book 3.3

Mars Society Desert Research Station
Utah, USA

Original Mayan Pyramid
Palenque, Chiapas, Mexico

Machu Picchu
Peru

Andreina Experiencia ARS
Isla de Coche, Coche Paradaise, Venezuela

The Americas



iTunes
Tips &Tricks



Every year, we update our iTunes Tips & 
Tricks section of The Free iPod Book to 
include more - and more up-to-date -
tips on how to use Apple’s free media 
management program iTunes. This 
year, we’re bringing you over 140 
concise and fun tips, which have been 
packed into 70 easy-to-read pages for 
quick digestion. Don’t be fooled by the 
length: this section alone has enough 
meat to stuff its own book, only it’s been 
organized in a more interesting way.

While it would have been easy to create 
a boring list of all of iTunes’ features and 
walk through them like a manual, we 
know that no one wants to read another 
manual. So we focused on issues 
people ask us about all the time -
including our top questions from Ask 
iLounge - and provided direct answers.

We started writing this guide with one 
benchmark: if a tip can’t enhance the 
way you use iTunes, it shouldn’t be in 
here. Some of these tips may help make 
your experience more efficient, while 
others may show you completely new 
features you didn’t know about. And 
some of them are basic, while others 
appeal to power users. 

Our hope is that reading this section of 
the Book will equip you with tips that 
you’ll enjoy using whenever you play 
with iTunes. Maybe you’ll even consider 
yourself a power user when you’re done!
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Big Deal Tips: Start Here
Copy from your iPod to your Mac	 196
Copy from your iPod to your PC	 199
The importance of iTunes Preferences	 146
Updating or Restoring your iPod	 217

Art, Game, Photo and Video Tips
Add Album Artwork automatically	 214
Change photo sync order	 217
Correct corrupt iPod album art	 205
Delete Artwork from songs	 154
Finding Artwork to add to songs, and more	 154
Get tips and tricks for your iPod Games	 186
Give presentations from an iPod	 207
Going with the (Cover) Flow	 216
Keeping track of your Music Videos	 215
Pick a Video’s Poster Frame	 205
Ready your videos for the iPod or Apple TV	 201
See videos and more in iTunes’ bottom left corner	 150
Smarter playlists for TV shows	 215
Tag TV Shows and Music Videos properly	 203

Expanding iTunes’ Power
Add PDFs to your Library	 149
Control iTunes with Widgets: Mac & PC	 177
Control iTunes with Widgets: Mac OS X 10.4+	 178
Enhance iTunes with helpful AppleScripts: Mac	 208
Enhance iTunes with helpful JavaScripts: PC	 209
iTunes, AirTunes, and icons, oh my!	 160
Password protecting your shared music	 191
Sharing your music	 153
Take control of iTunes from the Dock or Tray	 177
Understanding Interactive Booklets	 149
Understanding Podcasts	 166
Use iTunes as an alarm clock	 195

Formats: Smart MP3, CD and DVD Tricks
Back up your music to DVD	 194
Burning MP3 CDs	 171
Burning smarter CDs with CD Text	 217
Choosing your song format	 148
Export your songs to other devices	 149
Play songs on your iPod from other digital music stores	 199
Set tracks to save where you left off, or slow down	 187
Splitting a song	 185

Improve Your iPod + iTunes Experience
Creating On-The-Go Playlists for editing in iTunes	 151
Edit song info like a pro	 183
Editing Tags	 159
Evoke Front Row without an Apple Remote (Mac)	 173
Find and delete duplicate songs	 173
Gapless Playback	 168
Multiple On-The-Go Playlists make iTunes easier	 176
Pre-built Smart Playlists	 189
Rate on iPod, synchronize with iTunes	 163
Rate on the fly	 177
Setting multiple Genres for a song	 174
Smart Playlists	 149
Sorting your music - the basics	 161
Sorting your music - custom	 162

iTunes Store Tips
Continue interrupted iTunes Store downloads	 209
Creating links to the iTunes Store	 168
Cut impulse purchases at the iTunes Store	 167
Find free iTunes Store downloads	 204
Identifying iTunes Plus Songs and Albums	 218
Kill the iTunes MiniStore	 146
Make an iTunes Store wishlist	 198
Managing Your iTunes Plus Account Settings	 219
Review previous iTunes Store purchases	 209
The iTunes Store’s Power Search	 174
Track iTunes Store sales	 195
Upgrade (Some) Music to iTunes Plus	 219
What’s iTunes Plus? Higher-Quality, DRM-Free Music	 218

iPhone-Specific Tips
Adding Music, Movies and Photos to iPhone	 221
Back up your iPhone: the Preferences Tab	 222
Help Apple trace iPhone bugs	 223
Keep your iPhone’s Software and content fresh	 222
Synchronizing Contacts, Calendars, Bookmarks & 
Mail to iPhone: the Info Tab	 221
Use iPhone as a Contact & Bookmark conduit	 223
Using iTunes to activate an iPhone	 220
Why iPhone’s no iPod: no Disk Mode, no Drag & Drop	 220

Just For Fun
Add a keyboard shortcut for the Equalizer (Mac)	 213
Capturing the Visualizer	 198
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Control the volume with the scroll wheel on your mouse	176
Formatted versus unformatted space	 191
Learn what was hot on the charts	 175
Make your own Celebrity Playlist with iMix	 186
Print CD jewel case inserts and library listings	 204
Round up your favorite radio stations	 188
So how big is YOUR library?	 156
Use alternate visualizers in iTunes	 210

Listening and Parental Tips
Apply Equalizer settings to individual songs	 171
Be a protective parent	 200
Create your own Equalizer presets	 175
Create your own stripped-down iPod interface for kids	 213
Equalizers: the final frontier	 170
Limit your iPod’s and iTunes’ output volume	 211
Listen to your iPod through computer speakers	 212
No more crappy previews on dial-up	 197
Save your ears with Sound Check	 192

Look and Feel
Better viewing for bigger videos	 155
Decoding those buttons	 153
Get rid of unused items from the iTunes Source List	 151
Getting rid of the arrows	 182
iTunes Mini Player	 147
Make your iTunes window the perfect size (Mac)	 171
Maximizing the Mini Player	 147
Quicker window resizing (Mac)	 162
Show off your EQ	 157
Switching Chapters: the magical appearing option	 158
Take control of the Visualizer	 169
Tidy up iTunes’ Source column	 203
Time for a change	 180
Windowed versus full-screen Visualizer	 165

Multiple Computers or Multiple iPods
Deauthorize all computers on an iTunes account	 202
Deauthorize your old computer	 186
Moving your iTunes music folder to a different drive	 184
Multiple iPods, one computer	 197
Sharing iTS songs on multiple computers	 184
Take your music with you (switching computers)	 185
Use multiple separate iTunes libraries on one computer	 202

Power User Tips & Saving Time
A more colorful way to look at iPod capacity	 214
Avoid the blank CD warning	 183
Basic iTunes shortcuts	 152
Check/uncheck multiple tracks at once	 207
Create a Playlist from the Browser	 164
Dealing with your iTunes Phone	 156
Delete Playlists without warning	 152
Delete songs from within a playlist	 206
Deleting your entire iTunes Library	 192
Ditch the battery icon on black-and-white iPods	 188
Find out where a song is hangin’	 181
Finding bad tags with Browse mode	 194
Folders on a Disk Use mode iPod	 163
iSync your iPod (Mac)	 190
Keep Compilations together	 206
Keep computer-deleted files on your iPod	 182
Keep the peace between OS X and OS 9 (Mac)	 193
Keep your iPod from auto-updating	 172
Managing iTunes downloads	 194
Managing your Library with checkmarks	 181
Manually managing song, podcast, and video 
transfers to and from your iPod	 179
One letter answers	 181
Open the iTS (or a Playlist) in a new window	 172
Play the songs you want with double Smart Playlists	 212
Quick Playlists from selections	 162
Quickly add songs from CDs to Playlists	 179
Quickly clear searches	 146
Quickly highlight the currently playing song	 157
Quickly queue up a song in Party Shuffle	 189
Recover your lost iPod’s serial number (Mac)	 180
Resetting the Play Count	 176
See the exact play time	 156
Show any song’s location	 196
Shuffle, a little less random (Smart Shuffle)	 201
Special-click for Smart Playlist	 157
Take manual control of contacts	 165
Track how often you skip songs	 176
Use Airport Express with other audio applications	 203
Use an iPod with Mac OS 9	 182
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The importance of iTunes Preferences

Throughout these tips, the second most important 
screen in all of iTunes is the 
Preferences window. Because 
it wants to keep the main 
iTunes screen simple and 
easy, Apple hides almost 
all of iTunes’ most powerful 
features under various “Tabs” 
in Preferences. To access 
Preferences on a PC, go to 
the top of the window, select 
Edit, and find Preferences 
near the bottom. You can also 
hold the Control key and hit 
the Comma key ( , ) to bring 
it up automatically. On a Mac, 
Preferences is under the 
iTunes menu option, or just hit 
Command and Comma.

We’ll explore all of the tabs in the sections that follow.

Quickly clear searches

The Search field, located in the upper right-hand 
corner of the iTunes window, is a great way to find 
music efficiently. Did you know there is a way to 
make the searching process even more efficient? 
Instead of highlighting the text in the Search field 
and then pressing Delete, all you need to do is click 
the little grey “X” button on the right side of the field. 
This clears whatever text is in the field, allowing you 
to quickly return to your full Library view or start 
another search.

Kill the iTunes MiniStore

It’s incredibly annoying - thank 
Apple’s marketing department 
for the iTunes MiniStore, a big 
blue bar with music purchase 
recommendations that appears 
by default at the bottom of 
your Library. After numerous 
complaints about the MiniStore, 
Apple now provides clear 
instructions on how the MiniStore 
works and requires a new user to 
specifically opt-in before turning 
it on.

If you have opted to turn on the MiniStore and later want to get 
rid of it, the option to turn it off can be found under the View 
menu. Simply select “Hide Ministore” and it will disappear from 
the bottom of the screen and never bother you again. 
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iTunes Mini Player

You’ve heard of the iPod mini and Mac mini - this is iTunes Mini. If you’re tight on screen real estate, you can shrink iTunes 
down two sizes. On a Mac, click the green zoom control button in the top-left corner of the application. On a PC, hit 
Control-M. Gone are your Source and Song lists, replaced with a small control window with only Play/Pause, 
Next/Fast Forward and Previous/Rewind buttons, a volume slider and a status display. 

And if the Tunes Mini Player isn’t small enough for you, you can go smaller. 
Just click and drag the bottom-right edge of the iTunes mini window a tad 
to the left and you will be greeted by this even smaller, screenless version of 
iTunes Mini - we’d call it iTunes Shuffle, but it lacks the same-named iPod’s 
shuffle feature. It hasn’t changed much from version to version of iTunes, 
remaining the simplest way to access your music library

Maximizing the Mini Player

If you like the functionality of iTunes Mini, but hate digging through open windows to find your little pal, this tip is for 
you. There is an option buried deep within iTunes that keeps iTunes on top of other windows. Go to the Preferences 
(iTunes > Preferences on Mac, Edit > Preferences on PC) window and select the Advanced Tab. Make sure you’re in the 
General section. Then, if you look at the bottom of the window, you’ll see a check box setting for Keep Mini Player on top 
of all other windows. Check this, and you’ll never have to go looking for your iTunes controls again.
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Choosing your song format

You already know that iTunes is a digital jukebox - but did you know that iTunes 
can play different formats of music? This tip provides detailed recommendations 
on the right format to use for converting your CDs.

Since April of 2003, the Advanced Audio Codec (AAC for short, part of the 
MPEG-4 compression standard) has been Apple’s default for encoding music 
with iTunes. Other options are still available under the Preferences window, 
under the Advanced Tab, under Importing. Apart from AAC, you can also 
choose MP3, AIFF, WAV, and Apple Lossless. While you’re on this screen, we also 
recommend unchecking Play songs while importing, due to its adverse affect 
on importing speed - CD rips will take 25-50 times longer, depending on your 
CD drive.

Different formats have different benefits, so we discuss them all below. For 
reference purposes, we’ll show you the file size of U2’s “Vertigo” encoded in each 
format, at our recommended settings.

MP3 – Recommended setting: Higher Quality (192 kbps). MP3 is the most 
popular of the compressed music formats, but it’s old, and requires more disk space to get equal sound quality compared to 
AAC. However, unlike AAC, it is compatible with most non-iPod music players, and is also compatible with virtually all home 
and car stereos that natively support playback of compressed digital music. We recommend MP3 if you are concerned with 
compatibility with various players, and aren’t worried about storage size. Vertigo size: 4.5MB.

AAC – Recommended setting: at least High Quality (128 kbps). This is the same quality and format that Apple uses for songs 
purchased from the iTunes Store. However, the iPod is the only major portable music player it will work with, and it’s currently 
incompatible with many home stereo conduits such as TiVo’s Home Media option. If you’ve gone iPod and iTunes, plan never 
to switch, and want small files, use this format because of its small size and its quality. Otherwise, go with MP3. 
Vertigo size: 3.1MB.

WAV and AIFF – Recommended setting: Automatic. WAV and AIFF are uncompressed formats; WAV is a PC format from 
Microsoft, AIFF a Mac format from Apple. Neither one is wise to use for today’s digital music players, and though WAVs play on 
more devices,, you can get literally identical sound quality from Apple Lossless while consuming less space. Consider WAV only 
if you need literally perfect CD rips and will use them on non-Apple products. Vertigo size in either WAV or AIFF: 32.8MB.

Apple Lossless – Recommended setting: Automatic. Apple Lossless Codec was introduced by Apple in 2004. It provides 
quality similar to AIFF and WAV, but the files it produces are about 2/3 the size of AIFF or WAV. It is compatible only with Apple 
products. Use this if you are really concerned about quality and aren’t worried about storage size. Vertigo size: 23.6MB.

Additional options can be found by selecting “Custom” from the “Setting” menu, which will allow finer control over the bit-
rate and other encoding preferences. Most notable among these is the option for Variable Bit Rate Encoding, or VBR, which is 
supported in both the MP3 and AAC encoders in iTunes, a setting that offers a better potential trade-off between file size and 
quality, since a higher bit-rate can be used for portions of the audio track that require it, rather than limiting the entire track to 
a lower bit-rate. Note, however, that some devices have issues playing VBR files, the reason Constant Bit Rate (CBR) is common.

We feel safest recommending the MP3 format with CBR encoding 
because it’s close to future-proof: almost every device on the market 
supports it. MP3 format files at 192-224 kbps are similarly close to future-
proof, since they’ll sound good no matter what hardware, software, or 
accessories you decide to use in the future. Who uses AIFF, WAV, or Apple 
Lossless? Relatively few people; those who are obsessed with audio 
quality and have sophisticated speakers or headphones (typically $300
and up) capable of clearly showing imperfections in compressed audio.
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Add PDFs to your Library

Starting with iTunes 4.7, Apple enabled iTunes to store 
Adobe PDF documents - the same digital document format 
you’re reading right now. While Apple uses the PDF format 
to create the “Digital Booklets” it sells with albums, you can 
add any PDF document you want into iTunes by dragging 
and dropping it from your PC or Mac’s desktop. Double-
clicking on it in iTunes will open a separate viewer program. 
PDFs are indicated in your library with a book icon, and as 
of the date of publication of this Book have no way to play 
back on an iPod. iPhones, however, are said to be different.

Smart Playlists

Smart Playlists are one of the best features in iTunes, especially if you have a large library of music. Instead of forcing you to 
sift through and manually choose songs, Smart Playlists let you choose conditions for the automatic selection of songs, and 
also allow you to limit their size to a certain number of songs or storage space. These conditions can be combined to create 
interesting mixes of songs, or to target a specific type of song. By default, iTunes comes with five pre-made Smart Playlists - 
90’s Music, My Top Rated, Recently Added, Recently Played, and Top 25 Most Played. To get specifics on these, go to the top of 
your screen on Mac or window in Windows, and find File. Pick Get Info, or use the Mac Command-I keyboard shortcut, or PC 
Control-I keyboard shortcut.

Here’s a practical example of how a Smart Playlist can be built. You’re throwing a 60’s-themed party from 7PM-11PM, and only 
want good songs that are relatively short and upbeat. You could pick all these by songs by hand and try to make sure the 
Playlist is about four hours long, or you could take three minutes to set up a Smart Playlist to do it for you. Here are the steps:

1.	Go back to File and choose New Smart Playlist (or use the Option-Command-N Mac / Control-Alt-N PC shortcut).
2. 	Start by setting the first parameter to Year, and select a range of 1960 to 1969.
3. 	Click the + button to add another parameter.
4. 	Set this new parameter to My Rating, and select a range of 4 stars to 5 stars.
5. 	Click the + button once more.
6. 	Set this last parameter to Time, and select a range of 2:00 to 4:00.
7. 	To limit the time, click the first box next to the Limit parameter, change the songs tag to time, and enter 4 hours.

If done correctly, your screen should look like the example on the next page. continued

Understand Interactive Booklets

Last year Apple also began including “Interactive 
Booklets” with many of their albums. Like the 
aforementioned Digital Booklets, Interactive Booklets are 
included to provide a form of virtual liner notes similar 
to those found with a CD, but as the name implies 
are interactive, rather than being a static PDF. These 
Interactive Booklets use Quicktime Flash, 
which requires the appropriate setting to 
be enabled in your Quicktime preferences 
in order to see them. This setting can be 
found in the Quicktime Preference Pane 
under System Preferences on a Mac, or in 
the Quicktime Control Panel in the Windows 
Control Panel. 
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Not only is this a quick and easy way to create specific Playlists, but the Playlist remains dynamic - meaning that it will 
automatically update itself as you add more music to your Library and edit your ratings. You can use these parameters to 
create all kinds of custom Playlists, and they’re a great tool for selecting content to go onto your iPod. The only hitch: you’ll 
need to have properly tagged and rated music, so do your best.

See videos and more in iTunes’ bottom left corner

If you’ve read the earlier tutorials in this Book, you already know that you can add 
album artwork to iTunes for viewing on color-screened iPods and nanos. But the 
latest versions of iTunes are actually capable of more.

If the bottom left of your iTunes window is nothing more than the bottom of 
your Source list, click the Show Artwork/Videos button - fourth from the left - or 
the use the Mac Command-G / PC Control-G keyboard shortcut. A small square 
window will appear.

If you’ve downloaded a video from Apple, or 
imported your own video into iTunes, it can play 
in this spot - go to iTunes’ Preferences window, 
Playback Tab, pick Play Videos: In The Main 
Window, and click OK. Any video clip in your library 
will play here; clicking on the video will open up a 
larger playback window on your screen. 

Note: if your library only contains audio files, this 
window will show album artwork or nothing at all. 
You can always close the window by clicking on the 
Hide Artwork/Videos button, fourth from the left.
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Creating On-The-Go Playlists for editing in iTunes

All screened iPods since the third-generation iPod can create their own 
Playlists. They’re called On-The-Go Playlists, a feature perfect for people 
who don’t have time to create Playlists when they’re using their computers, 
but have time to use their iPods. 

To add any song to your On-The-Go Playlist, simply scroll to the song you 
want and hold the iPod’s center Action button until the song flashes. This 
method also works for adding entire Playlists, Artists, Albums, Genres, 
Composers, and Audiobooks to the On-The-Go list. 

You can find your On-The-Go Playlist by navigating to Music > 
Playlists > On-The-Go on your iPod, and can even listen to it while you 
continue to add songs. To delete a song from your On-The-Go Playlist, 
highlight the song while viewing the list, then press and hold Select until 
the song flashes. When you release the Select button, the song will be 
deleted. To clear the whole list, scroll to its bottom and select Clear Playlists. 
This next screen gives you a last chance to hit Cancel or Clear Playlist to 
go ahead and finish the deed. But keep your imperfect lists - you can open 
them later in iTunes and edit them to perfection. Make sure to rename them 
for easier reference.

 

Get rid of unused items from the 
Source List

iTunes 7 added a number of new 
categories in the Source List for items 
such as Movies, TV Shows, Podcasts, 
Audiobooks and iPod Games. If you don’t 
ever use these items you can hide them 
from your Source List.  Just go to the 
Preferences window and deselect the 
appropriate items. Doing so will eliminate 
clutter by removing these unnecessary 
categories.

Note that since all of the different types of 
content are now segregated into different 
categories, iTunes will warn you if you’re 
turning off an item that might cause you to 
lose access to some of your content. Don’t 
despair, however, since even if you hide a 
section your content remains in your iTunes 
library and you can see it again simply by 
returning to the Preferences window and 
re-check the appropriate options.
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Basic iTunes shortcuts

Call them geeky, but if you want to save time, you’ll find these keyboard shortcuts handy. Insanely great things can be 
accomplished at lightning speed if you remember a few easy commands.

Action	 PC Keyboard	 Mac Keyboard

Play or Pause song 	 Space Bar	 Space Bar
Play next song 	 Control + Right Arrow	 Command + Right Arrow
Play previous song 	 Control + Left Arrow	 Command + Left Arrow
Increase the volume	 Control + Up Arrow	 Command + Up Arrow
Lower the volume 	 Control + Down Arrow	 Command + Down Arrow
Mute song 	 Control + Alt + Down Arrow	 Command + Option + Down Arrow
Eject a CD  	 Control + E	 Command + E
Fast-Forward 	 Control + Alt + Right Arrow	 Command + Option + Right Arrow
Rewind 	 Control + Alt + Left Arrow	 Command + Option + Left Arrow
Open iTunes preferences 	 Control + Comma ( , )	 Command + Comma ( , )
Quit iTunes 	 Control + W	 Command + Q
Minimize iTunes window 	 Control + M	 Command + M
Show or hide Artist and Album	 Control + B	 Command + B
View Visualizer window	 Control + T	 Command + T
Show iTunes + ITunes Store Help	 Control + ?	 Command + ?

Delete Playlists without warning

If you create and remove Playlists constantly, you’ll find this tip handy. When you try to delete a Playlist, an annoying 
dialog box pops up asking you if you’re sure you want to delete the Playlist. You could select the “Do not ask me again” 
option - our preference - but novice users will find that this isn’t easy to undo later. 

An alternative is to bypass the warning altogether. Highlight the Playlist, then press Control-Delete on the PC or 
Command-Delete on the Mac. A harder-core solution is to use Alt-Delete on the PC or Option-Delete on the Mac to 
remove the selected Playlist and delete all of the songs it contains from your library. You’ll thank us when you’ve tested 
this on your Backstreet Boys collection.
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Decoding those buttons

They sit there, staring at you, taunting you with their
mysterious icons. What do they do? Why are they there?

The first button adds a Playlist to your Source list. Next 
activates Shuffle playback mode. The third turns Repeat 
Playlist on, or Repeat One Song if you press twice. Fourth 
opens and closes the Album Artwork and Video window. 
Hold your cursor over any of them, and an explanation will 
appear in a little yellow box. 

Sharing your music

Beginning with version 4.0, iTunes added an easy way to share music with others on your network. iTunes searches for 
shared music by default, but you must be proactive to share your own. To let other computers share your music, go to the 
Preferences window, and click the Sharing Tab. Then select the Share my music checkbox and you’re off and running. 

This feature is particularly useful if you have more than one computer at home, but want access to your music no matter 
which one you’re using. Note that there is a way to Password protect your music - we’ll look at it later - and also that your 
music is streamed to computers sharing your music. No files are copied over. 

You should also ensure that you give your library 
a unique name if you’re going to be sharing it in a 
work or campus scenario.  Unlike previous versions of 
iTunes, the library name is now set on the General Tab, 
rather than within the sharing preferences.
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Finding Artwork to add to songs, and more

Elsewhere in the Book, we explained how to add Album 
Artwork to your iTunes collection, but we didn’t tell you 
where to look for it. Assuming you don’t have a scanner or 
the ability to digitally photograph the album covers you 
own, we recommend Amazon.com, Walmart.com, and 
Google.com/images as places you can search by album 
name and artist. 

Once you have found and saved your picture, you can add 
it to a whole CD’s worth of songs. Select all of the tracks in 
iTunes before dragging the cover over to the bottom left 
of the screen. You can also copy and paste images from
your clipboard.

Delete Artwork from songs

Adding Album Artwork (see previous tip) increases the file 
size of songs. If you’re running low on space on your iPod, 
you might want to trash a cover from a single track. press 
Control-I on your PC / Command-I on your Mac, and find the 
Artwork box. Click on the Artwork once and hit Delete. To 
delete the Artwork from a group of songs, select them, press 
Control-I on your PC / Command-I on your Mac, and put a 
check mark in the empty Artwork checkbox in the right 
side of the Song Information window. Hit OK and you’ll be 
Artwork-free. Just be careful - it’ll take time to replace.
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Better viewing for bigger videos

So the tiny little window in the bottom left of the 
screen isn’t your favorite place for videos? Fair 
enough. Thankfully Apple agrees that a tiny screen 
isn’t the only way movies should enjoyed. 

If you go into iTunes Preferences, then the 
Playback Tab, you’ll see an option called Play 
videos: with four choices. Selecting in the main 
window squeezes videos into the bottom left 
corner. In a separate window creates an iTunes 
viewer - based on the QuickTime movie player - that 
you can move wherever you want on the screen. 

Both the full screen and full screen (with visuals) 
options will scale the video up to take up your 
entire monitor.  Depending on the quality of what 
you’ve selected, it might not look great when 
magnified. The difference between these last two 
options only applies when working with playlists 
that mix both music and videos.  The standard “full 
screen” option will return to the normal iTunes 
window when playing to a normal audio-only music 
track, while the “full screen (with visuals)” setting 
will leave iTunes in full screen mode and display 
the visualizer full-screen for any audio-only tracks.  
This is a great feature for mixing music videos with 
normal music tracks in a party setting.
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See the exact play time

It’s not advertised heavily, but there is a way to change the Time 
display. By simply clicking on the bottom bar, you can toggle 
between an abbreviated Time (1.1 hours, in our example), or 
Detailed Time (1:08:15 total time). This can be extremely helpful 
when making Playlists that need to be an exact length, such as 
Playlists meant for CD burning.

 

So how big is YOUR Library?

iTunes doesn’t obsess much over numbers, but it does have one 
tiny little display that’s worth checking out. If you look at the 
bottom center of its window, you’ll notice three numbers: 
Number of Songs, Time, and Storage Space used (MB or GB). 

If you switch between your Library and a Playlist, you’ll notice 
that the numbers change - the window always shows you totals 
for whatever portion of your collection you’re viewing. It also 
separates music, movies, TV shows, and other parts of your 
Library, so you can see how much space each portion uses.

Dealing with your iTunes Phone

Back in our first edition of The Free iPod Book, iTunes 
Phones were just a rumor, but today, there are three 
such wireless phones sold in various countries: ROKR, 
SLVR, and RAZR V3i. Connecting any of them to your 
computer with a USB cable will bring them up in 
iTunes, and enable you to configure them in much 
the same way as you would an iPod shuffle, using 
Autofill to randomly dump songs onto the phone, 
allocate its 512MB of storage space partially to songs 
or data, and convert songs automatically into small, 
128kbps AAC tracks that consume less space. 

Because they’re capped at 100 songs by Apple, 
Motorola’s iTunes Phones are more limited than any 
true iPod, and certainly more than Apple’s iPhone. 
The only non-
shuffle benefit is 
the ability to turn 
album artwork on 
or off; you’ll see 
tiny, iPod nano-
style album art if it’s turned on. You’d might as well keep it on. 

If you’re not interested in using Autofill, dropping files onto the phone is just like using an iPod: select files from your 
library, and drag them over to the phone icon in your Source list. 

Simple, eh? 
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Special click for Smart Playlist

If you’re a power user, you usually create Smart Playlists instead 
of normal ones. And you already know that iTunes gives you 
an easy-to-use button to create normal Playlists (located at the 
bottom of the Source list). But did you know you can use this 
same button to create Smart Playlists? By holding Option on 
a Mac or Shift on a PC when going for this button, the plus 
symbol changes to a gear symbol. Clicking while holding down 
Option or Shift then brings up the window for you to choose the 
conditions for your new Smart Playlist.

Show off your EQ
 
You’ve seen the black and white Apple logo that changes to track information when you play a song. Ever wondered 
what that little circle with the triangle inside did? Not much, but click it and see. Go ahead. We’re waiting. Don’t want to? 
Okay. Clicking the button just switches the status display from song/artist/album and elapsed time to a small digital EQ 
meter. Be sure to share this tip with your friends.

 

Quickly highlight the currently playing song

There are times when you’ll be too mired in a search for Playlist-worthy songs to want to hunt down the song you’re 
currently hearing. It turns out that you can always find the song you’re listening to at any given moment by hitting a set 
of two keys at once. PC users can hit Control-L, while Mac users should hit Command-L. The playing song will appear in 
your window, highlighted, and ready for you to place wherever you desire.
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Switching Chapters: the magical appearing option

In the last edition of our iPod Book, we introduced the “Chapters” button, 
which enabled you to move from section to section of an extended audio 
or video program. If you had used this feature before, you may have 
noticed that in iTunes 7, the magical button for this has disappeared from 
the iTunes window.

Instead, iTunes now displays an additional “Chapters” menu whenever you 
begin playing content that includes chapter markers.  For audiobooks and other audio-only content, the Chapters menu 
will simply display a text-based list of chapters and their time intervals into the book. For video content such as movies 
purchased from the iTunes Store, the Chapters menu will display titles similar to those found on the scene selection 
menu of a DVD, including small thumbnails for each chapter. The video chapter menu can also be accessed from the 
video playback window, where it appears as a button on the video controls overlay.

In addition, many podcasts are 
using the Chapter feature to include 
photographic or artistic narration 
for their sections. In the Ricky Gervais 
podcast, each chapter specifies a 
segment of the show; in city guides 
distributed by Podguides.net, each 
picture and chapter is for a different 
stop on the walking tour, so you can 
see what you’re supposed to be seeing 
when you’re walking - ahead of time 
if you’re using iTunes and a black-and-
white iPod, or during the walk if you 
have a color-screened iPod. We can’t 
wait to see what people do next with 
this great feature - particularly on 
future iPods. 
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Editing Tags

Having accurate Tags for your songs is key to getting the most from iTunes. You probably got most of them from iTunes, 
which used an Internet service called the CDDB to come as close as possible to the right details. But what do you do if the 
Tags from the CDDB aren’t correct, or if they aren’t there at all? And you might be asking, “Exactly what are these Tags and 
how do they work?” Fear not, all will be answered here.

ID3 Tags are a block of information in an audio file that describes the audio’s contents. You can edit the Tags shown in the 
Library window by simply clicking on the text and entering whatever you want. 

Since you’ll often prefer to change more than one Tag for a song, there is a menu for just that purpose. It can be accessed 
in iTunes by selecting a song and selecting File > Get Info from the menu or using the Mac’s Command-I or PC’s Control-I 
keyboard shortcut. Once here, you need to select the Info Tab. Your window should then look something like this:

continued
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From here, you can change as many Tags as you need. But it can take a while to edit songs one by one, so if you need to 
change Tags for multiple songs at once, just select the songs you want to change and go through the same steps above 
(minus clicking the Info Tab) to bring up the window. It will look like this:

This is a simple way to fix problems such as a misspelled Album Tag or Artist or to add the Year - if missing.

iTunes, AirTunes, and icons, oh my!

Notice something different between this rack of bottom right corner icons 
and the ones on your version of iTunes? That little Speakers box only appears 
when you’re using Apple’s AirPort Express ($129), a small white wireless 
device that - amongst other things - lets you pump high-fidelity versions of 
iTunes music directly into a home stereo, using analog or optical output. 

Apple calls this feature AirTunes, and assuming that you have more than 
one pair of speakers connected to iTunes, you can control which speakers 
are hearing iTunes at a given moment. Better yet, if you have multiple AirPort 
Express units connected to different sets of speakers, you can broadcast the 
same iTunes song to more than one speaker set at the same time.

What about the other buttons?  The first is a shortcut for the iTunes 
“Browser” (this was located in the top-right corner on earlier versions of 
iTunes), and the second is an eject button.  It’ll open your Mac or PC’s CD/
DVD drives so you can insert a CD, and then close them with a second 
button press. 

Veteran iTunes users will notice that the Equalizer and VIsualizer buttons 
are no longer there.  These options can now only be accessed from the VIew 
menu or their corresponding keyboard shortcuts.
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Sorting your music - the basics

iTunes is a music player first and foremost, but it also acts as one of the best tools for sorting and finding your music. 
By default, iTunes sorts your music by Artist, but you can change this simply by clicking on the top of one of the other 
columns - by default they are Song Name, Time, Artist, Album, Genre, My Rating, and Play Count.

You can rearrange these by clicking their headings and dragging them right or left, and you can add or remove them by 
Right Mouse Button-clicking (or Mac Control-clicking) in the heading bar.

As you can see above, you can customize this view to your listening style by adding as many sorting columns as you’d 
like. This is just one way iTunes’ flexibility lets you enjoy your music the way you want.

One note: for whatever reason, Apple wants you to keep Song Name on the left. Although the columns can be shuffled 
around, the Song Name column is not movable. We’re still keeping our fingers crossed for an “Artist column first” option.
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Quick Playlists from selections

If you have several songs selected and need to make a Playlist from 
them, simply select File > New Playlist From Selection or use the PC 
Shift-Control-N or Mac Shift-Command-N keyboard shortcut. All the 
songs you had selected will appear in a new Playlist, ready for you to 
give it a name. 

Quicker window resizing (Mac)

If you have a slower Macintosh, or if you 
have many applications open at once, you 
may notice a bit of stuttering when trying 
to resize the iTunes window. Fortunately, 
Apple realized this can be an issue and 
offers an easy workaround. By holding the 
Mac’s Command key when you click in 
the lower right-hand corner to resize, you 
will be dragging an outline of the window, 
not the window itself. Once the outline is 
the size you need, let go and the window 
will appear resized inside the outline.

Sorting your music - Custom

iTunes 7.1 has added some additional sorting capabilities to allow for 
improved control and the ability to override the sort order for certain 
tracks and/or artists.

For example, let’s suppose that you have some music by an artist such 
as “50 Cent.” When sorting by artist, these tracks would appear at the 
top of your iTunes Library listing. However, you might want to sort 
these tracks alphabetically based on the phonetic pronunciation of 
“Fifty” (or “Fitty,” for fans). In either case, the iTunes “Sorting” tab in the 
File Info properties can help you do this:

Simply enter the wording that you would like to use for sorting in the 
appropriate fields in the second column. iTunes will still display the 
correct artist name, but it will now be sorted alphabetically based on 
the word “Fifty” instead of as a number.

So what if you want to make this change to a lot of tracks at once? To 
do this, simply make the change to a single track, and then right-click 
on that track in iTunes, and choose to “Apply Sort Field” to all the 
matching tracks.
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Folders on a Disk Use mode iPod

You already know about Enabling Disk Use from earlier in this Guide. But do you know what folders you’ll find on an iPod 
with Disk Use enabled?

You should expect to see the same three folders on screened iPods: Calendars, Contacts, and Notes. These folders allow 
you to drop in your own data if you want, but as we explained earlier in the Guide, there are programs that do a better job 
of processing files for you. The iPod reads ICS (Apple iCal) and VCS (vCalendar) format calendar data, VCF (vCard) format 
Contacts, and TXT (text) format Notes. Notes can contain HTML-format links to other notes and very limited styling, but 
nothing sophisticated. There’s also at least one hidden folder on the iPod called iPod_Control, containing your iTunes 
library and preference files. Don’t play with the contents of this folder - let our recommended third-party software 
programs handle the lifting for you. Other files shown above are Mac OS X data you don’t need to worry about.

Color iPods may also have additional folders. A folder called DCIM holds digital photographs transferred to the iPod from 
a device such as Apple’s iPod Camera Connector. Another folder, Photos, will appear if you use iTunes to synchronize 
photographs for display on the iPod’s screen. And a folder called Recordings can store audio recordings make with 
devices such as Griffin’s iTalk and Belkin’s TuneTalk; this folder name is the same for newer, Dock Connector recorders too.

Of course, you can create your own folders on the iPod, too - that’s the point of Disk Use mode. Just don’t delete anything 
you find in the ones up here. And the iPod shuffle? No visible folders. Fill it however you like.

Rate on iPod, synchronize with iTunes

Rating songs in iTunes is a great way to help organize your music, but it’s 
even better to rate songs directly from your iPod. While playing a song, 
click the center button twice (three times for color iPods) to access the 
rating screen. Rotate the wheel clockwise to raise the rating and counter-
clockwise to lower it. Once you have the rating you want, click the center 
button once more to return to the Now Playing screen. 

When you reconnect your iPod to your computer, the ratings you changed 
on the iPod will transfer into iTunes. This method really helps out Playlists 
such as the default My Top Rated, and can help you in your quest to make 
sure so-so music doesn’t play unless specifically requested. You can change 
the ratings in iTunes at any time.

Regular iPod Regular iPod with Hidden Files Shown Color iPod
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Create a Playlist from the Browser

If you’re trying to quickly make a Playlist containing all the songs from an Artist or Genre, open the Browser (Edit > 
Show Browser or PC Control-B / Mac Command-B). Then select the Artist or Genre you want, and drag it to an open 
area in the Source list. You’ll have a Playlist containing all of the songs in the Genre or by that Artist. Remember: if won’t 
automatically update itself, so take the time later to create a Smart Playlist.
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Windowed versus full screen Visualizer

iTunes still includes a visualizer feature, although Apple’s taken away the 
button for it in iTunes 7, so you now have to go to the top-of-window or 
top-of-screen menu to find it.

If you select View, Turn on Visualizer, iTunes will show you some seriously 
cool fluid art in a window while your music plays. Once the Visualizer is on, 
you can even take it into full screen mode by selecting View, Full Screen.

If you prefer to always see your visualizer in full screen mode, you can 
customize these settings under iTunes’ Advanced preferences.

Take manual control of contacts

Your iPod is made for playing music, and it does so exceptionally well. It’s also handy to have your contact information on it, 
and you can use the programs we’ve recommended to do that. But if you feel the need to copy or make a manual change to 
the contacts on the iPod, don’t worry - there’s a way. First off, you need to have Disk Use enabled on your iPod. Then simply 
navigate to the Contacts folder on your iPod and remove or add any contacts (in VCF, vCard format) that you see fit. Most 
programs export into VCF format. Don’t forget to eject the iPod before disconnecting it, since it will be in Disk Use mode.



166

The Free iPod Book 3.3iTunes Tips & Tricks

Understanding Podcasts

Earlier in the Guide, we discussed 
Apple’s addition of podcasts to 
iTunes - it’s a way for iPod owners 
to easily download free radio-style 
programs to iTunes and the iPod. 
Downloading podcasts one-by-
one is relatively easy: go through 
Apple’s Podcast Directory, located 
in the iTunes Store, find a subject or 
broadcaster of interest, and click on 
the Subscribe button. 

But what happens after you hit the 
Subscribe button? Initially, iTunes 
will add the podcast to your Source 
list. By selecting Podcasts in your 
Source list, you can use Get buttons 
to download older Episodes of 
the podcast, and each one will 
go from gray to black on your list 
as it’s downloaded. You can also 
unsubscribe by using a button at 
the bottom right of the screen.

Each new podcast will also have a 
small blue dot appearing next to 
it, indicating that the podcast has 
not yet been listened to. Unlike 
the iTunes play count, which only 
increments after you’ve finished 
listening to a track, this blue dot will 
disappear as soon as you listen to 
any portion of an individual podcast 
episode.

In iTunes Preferences, you can 
control how often iTunes checks for 
new podcast episodes, how many 
new episodes to download, and how 
many episodes to keep.

Unfortunately, the “Keep” setting in the iTunes podcast 
preferences is a global setting that applies to ALL 
podcasts. The good news is that although you can’t 
set the number of episodes to keep for each podcasts, 
you can exempt some of your podcasts from being 
automatically deleted. Simply right-click a podcast 
heading, and choose “Do Not Auto Delete” from the 
menu.  This will tell iTunes that you do not want it to 
delete any episodes of that podcast automatically.

continued
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Cut impulse purchases at 
the iTunes Store

Saving up for that MacBook Pro 
and matching 30-inch Cinema 
Display? You may need to curtail 
your impulse buying. Here’s how: 
disable 1-Click purchasing. Just go 
to the Preferences window and 
click on the Store Tab. Then, check 
the button that says Buy using 
a Shopping Cart. Now, instead 
of  Buy buttons at the store, you’ll 
have Add buttons that let you 
gather several songs or albums in 
a cart. This way, you can view your 
cart with a total price after you’ve 
loaded it up and decide rationally 
whether you really need the new 
Lindsay Lohan single, or whether 
she’s just part of a phase you’re 
ready to pass through.

Note that you can also apply this setting on individual 
podcast episodes, so if there’s a particular episode you 
want to keep around for archival purposes, simply right-
click on the episode, instead of the podcast heading, 
and you can choose to preserve that one episode from 
automatic deletion.

Once this setting has been applied, you will notice that 
the next time you bring up the context menu, the “Do 
Not Auto Delete” option will have changed to “Allow Auto 
Delete” which allows you to remove the exemption for 
that particular podcast subscription or episode.

Sometimes when right-clicking on a podcast subscription 
heading you will also notice that BOTH options appear 
on the menu.  This simply indicates that some but not all 
of the episodes in the podcast have been individually set 
to disallow auto deletion.  Clicking on either option will 
reset all individual episodes appropriately.
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Gapless Playback

Traditionally, joining CD tracks has been the only way to 
get gapless playback, but now that’s just so iTunes 6.  
iTunes 7 and last fall’s firmware updates for the fifth-
generation iPod have finally added the long-awaited 
gapless playback feature, so you can get all of that 
gapless goodness in iTunes 7 and cheating methods are 
no longer required to work around it. The good news is 
that there’s nothing that you have to specifically do to 
enable gapless playback. As long as you’re using iTunes 
7, and either a fifth-generation iPod running firmware 
v1.2 or later, or a second-generation iPod nano, it should 
just transparently work - so long as you give iTunes the 
time to “determine gapless playback information” by 
scanning your files. Naturally, you’ll have to be using 
material that was gapless to begin with, such as a live 
concert CD or DJ mix CD that is already gapless. If the 
original CD plays with gaps between the tracks, chances 
are that neither iTunes nor the iPod are going to be able 
to do anything special with this, so don’t expect gapless 
playback to suddenly make all of your music gapless.

Keep in mind as well that gapless playback only works 
when you’re playing tracks in sequence. Using “shuffle 
songs” will not provide gapless playback, since that 
wouldn’t really make any sense (the songs can’t smoothly 
transition to each other if they’re in random order).

There is one option in iTunes itself that refers to gapless 
playback, but this actually has nothing to do with the 
iPod, or with whether tracks even play back gaplessly in 
iTunes. Rather, it is simply used to override the iTunes 
cross-fader feature, if you have that turned on. In this 
case, if you’re cross-fading between tracks, the cross-
fading will be omitted when moving between tracks that 
are tagged as being part of a gapless album, since the 
cross-fade would kind of ruin the whole experience.

Creating links to the iTunes Store

Having a store built into iTunes is nice, but 
sometimes you want to share a discovery with 
someone else. That’s where this tip comes in. 
There are three main ways to create links to 
the iTMS. You can sometimes - particularly 
on a Mac - drag a song into an application 
such as Mail or Entourage. Dropping the 
song creates a nice link right in your email or 
document leading straight back to that song. 
In any case, you can also create links by right-
clicking (or on Mac, Control-clicking) a song 
and selecting Copy iTunes Store URL.

The URL is now ready for you to paste wherever you need it. The third way 
is to use Apple’s iTunes Store Link Maker, found at apple.com/itunes/link-
maker/. Here you can enter the album, and/or artist to which you wish to 
link, then search for the right song.
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Export your songs to other 
devices

So you’ve created a monsterous iTunes 
library, and now you want to transfer 
your songs to storage devices other than 
iPods, like SD or CompactFlash cards. 
It’s easy. Select as many songs as you’d 
like, and drag them to your computer’s 
Desktop, or directly to the device you 
want to store them on. Copies will be 
made instantly. 

You can export a Playlist full of songs, 
too. Open the Playlist from the Source 
List on the left, then hit Control-A (PC) 
or Command-A (Mac) to Select All. Drag 
them all together. Easy, eh?

Take control of the Visualizer

If you’ve ever tried to show off Visualizer and found that it was 
misbehaving, showing off the most horrible color combinations 
imaginable, there’s a way to take control. If you hit the ? key, a little 
help nugget will appear on screen, and you can flip to a second 
nugget with another press of the ? key. But using the bigger list of 
keyboard shortcuts below, you’ll never have to look at the “puke 
colors” scheme again - that is, unless you want to be grossed out.

Key	 What it does		

A or S	 Changes Visualization effect
B	 Displays Apple Logo in center of the Visual
C	 Shows/Hides the current Visualizer settings
D	 Resets all settings to default
F	 Shows/Hides frame rate display
H or ?	 Displays Visualizer help
I	 Toggles track info display
M	 Switch between configuration modes (random, user-saved only, freeze)
N	 Choose between normal or high-contrast color modes
Q or W	 Toggle between waveform styles
R	 Displays a new Visual based on random settings
T	 Toggles frame rate capping – a feature used to keep iTunes’ processor demands low
Z or X	 Changes the color scheme
0 – 9	 Displays the user configuration saved to that number
Shift 0 – Shift 9	 Saves the current configuration to a number
Left or Right arrows	 Changes to previous or next song
Up or Down	 Increases or decreases volume (iTunes’ volume, not the system volume)
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Equalizers: the final frontier

iTunes includes a built-in Equalizer (EQ) that lets you make tweaks to ten 
different sound frequencies. changing the way music 
sounds. You can access it from the View menu.

If you want to play with the individual settings, you 
can, and we’ll tell you how. But most people will stick 
with Apple’s presets, which appear as a list above the 
frequencies. To use the equalizer’s basic functions, 
you can simply check the On box and select a 
preset from the popup menu. You can tweak any of 
them from there, or go back to the beginning by 
choosing Flat.

The first slider (Preamp) is a general volume booster 
and reducer. Leave this one as-is, and play with 
the other ten. We’d suggest you experiment with a 
handful of your favorite songs to see what sounds best across a bunch of them. 

Bass: The 32 and 64 Hz sliders cover the lowest 
notes - ones you’ll hear with a sub-woofer. 
Increasing these bands gives more depth to bass-
heavy music, such as dance music, reggae, and rap.

Midrange: The midranges are the next six sliders 
from 125 Hz to 4K Hz, and are where the majority of 
audible sound in music actually takes place. This is 
where the voices are, and where the guitars, pianos, 
drums and most other instruments reside. There’s 
still some bass at the low end (125 Hz) of this range.

Treble: The last two sliders, 8K Hz to 16 K Hz, affect 
the high, treble sounds. While most music tends to 
sit in the midranges, the trebles hold both the very 
high ends of many instruments, such as violins, 
cymbals and even high voices, but also contain very 
important harmonics, or sounds that give music a 
great deal of depth; if you cut these frequencies off, 
you’ll notice that the music sounds “empty.” 

Your EQ settings here will affect everything iTunes 
plays back, unless you use our later tip on selecting 
individual presets for iTunes songs.
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Make your iTunes window the perfect size (Mac)

Do you have to scroll horizontally to see all of your columns in the iTunes 
window? You could just drag the lower-right corner of the window to 
stretch it out enough to see your hidden columns (such as Time, Genre and 
Rating) - or you could try something simpler. On a Mac, Option-click the 
zoom control (green) button in the upper-left corner of iTunes. This will 
automatically make your window an ideal size so you can see everything.

Burning MP3 CDs

As you may already know, iTunes makes it easy to make custom CDs that play 
in standard CD players. But if you have a player with MP3 CD compatibility, you 
may want to be burning MP3 CDs instead, since they can hold upwards of 100 
songs. iTunes can do this. To turn this feature on, go to the Preferences window, 
and click the Advanced Tab, then Burning underneath. There, you simply click 
on the MP3 CD option. After inserting a blank CD, the bottom right of your 
iTunes window will let you burn an MP3 CD. Keep in mind that when creating 
Playlists that will be made into MP3 CDs, you’ll need to keep them smaller than 
the capacity of a CD (640-700 MB) rather than under a certain time.

Note that you can only create MP3 CDs from tracks that are, well, MP3s. iTunes 
will not automatically convert tracks that are in any other format (such as AAC) 
to MP3 for you when burning an MP3 CD.  You’ll get an error message if you try.
If you still have some tracks that are in MP3 format, you can continue burning 
the MP3 CD, but tracks that are not in MP3 format will simply be excluded.

Apply Equalizer settings to individual songs

Once you start fiddling with the iTunes Equalizer, you’ll 
quickly realize that there isn’t a perfect one-size-fits-all 
solution. Different songs use different instruments and 
frequencies, and the changes you make to one song’s sound 
will have a very different impact on another song’s overall 
sound. One song may benefit from increased bass, while 
another may sound muddy. Boosting the treble may help 
some instruments, but it will make cymbals and other high-
pitched instruments sound tinny.

With this in mind, you can apply Equalizer presets to 
individual songs, or to entire albums, as you wish. Select a 
song, then select File > Get Info. Click the Options Tab, then 
select a preset from the Equalizer Preset menu. For multiple 
songs, Equalizer Preset is on the bottom right of the Get Info 
screen.
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Open the iTunes Store (or a Playlist) in a new window

If you would like to have both your Library and the iTunes Store open at the same time in separate windows, just double 
click the store’s tiny green icon or the words “ITunes Store” in the Source list. Now you can mess around in both without 
switching back and forth within the same window. This tip also works for Playlists - but be sure you double click just its 
icon and not the name of your Playlist. Otherwise, iTunes will think you want to rename the Playlist that you’re trying to 
open in a new window. Bad iTunes, bad.

Keep your iPod from auto-updating

Every once in a while, you may want full control over the updating of your iPod. Perhaps you just want to play some 
songs from your iPod, or maybe you want to keep all those Johnny Mathis songs you just imported from finding their way 
into the public eye (or ear, as it maybe) via your iPod. You can turn manual updating on via the iPod Tab in Preferences, 
but if you like your automatic way of life and just want to use manual mode on occasion, you’re going to love this tip. 
Hold Shift-Control on a PC or Command-Option on a Mac when connecting your iPod until it appears in the iTunes 
Source list, and you will be in full manual control of your iPod - but the next time you connect, your iPod will be back to 
being fully automatic.
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Find and delete duplicate songs

If you have multiple occurrences of several of the same songs 
in your Library, and want a quick way to weed these duplicates 
out, fear not. iTunes 4.7 was first to add the much-requested 
menu item Show Duplicate Songs. Now found under View > 
Show Duplicate Songs, this feature does exactly what it says. 
By showing you only duplicates, it makes it easier for you to 
pick out the doubles and get rid of them. Just be careful, as it 
doesn’t discern between live and studio tracks or demos and 
remixes that have the same name.

Evoke Front Row without an Apple Remote (Mac)

Recent Mac owners already know that Apple’s Front Row is 
the best way to browse their iTunes music and video libraries 
from a distance - the Apple Remotes included with Intel-based 
Macintosh computers make that easy. But what if you want to 
access your libraries from within Front Row without a Remote? 
Press Command-Escape from virtually anywhere in the Mac 
OS X interface, and Front Row will pop up. The Arrow keys 
will cycle through the icons, while the Space Bar will select 
them. Hit the Escape key to go back a menu, and eventually 
exit Front Row, or just tap Command-Escape a second time to 
go back to OS X.
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Setting multiple Genres for a song

So, you have a weird song performed by Nelly and Tim McGraw. Is it Rap? Is it Country? Well, now you don’t have to 
decide between the two. Select the song, go to File > Get Info (or use the PC Control-I / Mac Command-I keyboard 
shortcut), select the Info Tab, and set the Genre to “Country, Rap.” Now the song will appear in Smart Playlists for both 
Country and Rap. This technique can be used on any song - just make sure you separate them with a comma. 
Note: this tip does not work for Browser mode.

The iTunes Store’s Power Search

The simple search feature on the iTunes Store is fine for most of your search needs. However, if you’re sick of the tons of 
results that show up when you search for a specific song title or artist, you should check out the store’s Power Search 
(near the top of the left hand bar). This feature lets you focus your results - for instance, if you search for “The Killers” in 
the artist field, the results won’t include tracks with just “Killers” in the song or album titles. You can also use the heading 
bar at the top of the power search window to filter your results to only include certain types of content such as music or 
TV shows.
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Create your own Equalizer presets

Once you’ve finished tweaking the Equalizer’s settings to perfection, it’s 
easy to save them for future use. Click the Equalizer’s popup menu, 
select Make Preset, enter a name for your preset, then click OK. You can 
then take the preset and apply it to individual songs, or use it across the 
board for all songs. And 
if you delete a preset, 
iTunes will ask if you want 
to remove it from 
all songs for which 
you have set it.

Learn what was hot on the Charts

So maybe you’re throwing a 1950’s theme party, or perhaps you’re just curious to hear what kind of music your parents 
listened to back when they thought they were hip.  Well, the iTunes Store now includes the Billboard Top 100, Top 
Country, and Top R&B charts going back to 1946.  These can be viewed in the US iTunes Store by going to the Browse 
option in the iTunes Store and selecting Charts from the left-hand column. Users of international iTunes Stores will need 
to log out and log into the US store to see the charts.

A more grass roots way to find new music is to sort through other users’ iMixes, which we’ll discuss later. 
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Resetting the Play Count

As you’ve probably noticed, iTunes keeps track of how many times 
you’ve played a song all the way through in a little tag 
call Play Count. This tag can be very useful in creating Smart 
Playlists - especially a Never Heard Playlist. But sometimes it’s nice to 
have a fresh start on the Play Count, especially if a relative has been 
over cranking your copy of Jethro Tull’s Greatest Hits on repeat. The 
easiest way to reset the Play Count is to select a song (or songs - this 
will work for as many as you can highlight), Right-click on a PC or 
Control-click on a Mac, and select “Reset Play Count.” A dialog box 
will appear asking if you really, really, really want to do it, and as soon 
as you hit Yes, the Play Counts of the selected songs are set back to 
zero. 

Track how often you skip songs 

iTunes 7 now includes the ability to track not only how many times you’ve listened to 
a song, but how many times you’ve skipped it.  This works in much the same way as 
the play count does, and can be shown in column view, added to a smart playlist, and 
reset in the same way that play counts can. If you start listening to a track and then 
skip it (by hitting the “Next” button) within the first 30 seconds, iTunes will add the 
current time to the “Last Skipped” field, and increase the “Skip count” by one. This will 
also work on newer iPod models (fifth-generation iPod with v1.2 firmware, or second-
generation iPod nano).

Note that this will only work in iTunes if you actually hit the “Next” button to move to the 
next track.  Simply selecting a new track from the iTunes track list does not increment 
the skip count. This can be a great way to filter through those playlists and quickly 
remove tracks that you really don’t regularly listen to any more, since if you’re skipping 
them regularly, perhaps they don’t need to be in your playlist any more.

Control the volume with the scroll wheel on your 
mouse

If you have a mouse with a scroll wheel, you’re in luck (take that, 
most Mac owners) - there’s an incredible treat just waiting in 
iTunes for you. Did you know that you can control the music 
volume in iTunes with your wheel? Just hover your pointer 
somewhere near the volume slider on the iTunes window and 
move your scroll wheel away from you to increase the volume 
and towards you to lower the volume. It’s almost enough to 
make us want to junk these one-button mice we’ve been using 
for all these years. Well, not really, but it’s something.
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Take control of iTunes from the Dock or Tray

One of the most convenient features of iTunes is the ability to control the application 
from the Mac Dock or Windows Tray. This feature is great for when you’re working 
in another program and have iTunes minimized to the Dock or hidden and want to 
control it without quitting what you’re doing by bringing the iTunes window to the 
foreground. By Right-clicking in Windows, Control-clicking on the Mac, or clicking 
and holding on the Mac, a menu pops up that lets you: see what song is currently 
playing, turn repeat on or off, toggle shuffle mode, pause/play the track, skip to the 
next song or jump back to the previous one. 

Rate on the fly

The above controls are all well and good, but 
this menu is best for rating your tunes. (Remember, 
ratings are key to getting the most out of Smart 
Playlists.) Start up an Unrated Songs Smart Playlist 
in shuffle mode while you’re working, and use the Dock 
or Tray’s menu to rate on the fly without wasting time 
switching to the iTunes window.

Control iTunes with Widgets: Mac & PC

Back in 2002, two guys came up with a superb free 
Mac program called Konfabulator, which allowed 
you to keep handy tools sitting on your computer at 
any time. The tools were so slick that Apple decided 
that it wanted to include them in its Tiger operating 
system, and just copied the idea. So the Konfabulator 
guys created a Windows version of Konfabulator, then 
teamed up with Yahoo! to give it away for free. 

Here are just a few of the over 90 (PC and Mac total) 
iTunes-related Widgets available from Yahoo!’s 
Widgets site (widgets.yahoo.com). iTunes Remote 
is an excellent and beautiful widget for controlling 
iTunes. iTunes Bar is a slim style iTunes remote great 
for the top or bottom of your screen, plus an album 
artwork viewer. Sing that iTune! automatically 
downloads the lyrics for the track currently playing in 
iTunes, and tags them into iTunes’ Lyrics field for the 
track, for viewing on the iPod. iTunes Companion 
seems to do everything: it will fetch a track’s artwork, 
lyrics, and iTunes Store links, enable extra hotkeys 
for iTunes, and announce (vocally!) the currently 
playing track. Did we mention it can publish the track 
information, cover art, and rating of the currently-
playing song to a web server? iLounge is our Yahoo! 
Widget, available for both PC users and Mac users, 
built to help you check out our latest news, headlines, 
help archives, and photo gallery. Download it from 
the link in the left-hand column on our main page.
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Control iTunes with Widgets: Mac OS X 10.4+

With Dashboard, Mac users are getting the best iTunes 
Widgets of them all. In addition to all of the Yahoo! 
Widgets, which work on any Mac, OS X Tiger users can 
download all sorts of free new ones that were made 
specifically for Tiger. They benefit from even better 
visual effects than the impressive Konfabulator Widgets, 
and offer very similar features. To download them, hit 
F12, hit the Plus button in the left bottom corner, select 
Manage Widgets next to it, and click on More Widgets 
in the Widget Manager that appears. You’ll go to Apple’s 
site, where a huge collection of Widgets (iTunes and 
otherwise) is available. Go to the Music category, and 
you’ll find a whole bunch of iTunes and non-iTunes 
options. Here are are some of our favorites:

Tempo: Do you DJ? With iBeat, simply tap the big button 
in time to a song playing in iTunes to get an accurate 
tempo measurement, then double-click on the number 
to write the it to the current track’s “BPM” tag in iTunes. 

iTunes Connection Monitor: Use your laptop’s iTunes 
on your college campus network? Find out who is 
connected to your iTunes’ Sharing feature, and precisely 
what they’re listening to!

Sing that iTune! and IgLyric: Use these widgets to 
automatically download lyrics to the tracks currently 
playing in iTunes, and tag them into iTunes’ Lyrics field, 
for viewing on the iPod!

Album Art Widget: This widget automatically fetches 
the current track’s album artwork from internet sources, 
and can assign it to the track in iTunes. Additionally, it 
allows you to rate tracks as you listen.

iTunes controllers: iTunes controllers like Apple’s 
standard one, miniTunes, DashTunes, Black ‘n’ Blue, and 
BezelTunes allow you to quickly change iTunes’ current 
track, playlist, volume, or -- in some cases -- song rating. 
Some even display the current album art! Experiment 
and find one you like.

iLounge. We have a Dashboard widget, too! Like our 
Yahoo! Widget, it’s built to help you check out our 
latest news, headlines, help archives, and photo gallery. 
Download it from the left-hand column on our main 
page, or from Apple’s Dashboard site.
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Manually managing song, podcast, and video transfers to and from your iPod

iTunes makes it easy to keep your iPod up-to-date with your latest media acquisitions. If your Library is small, it simply 
copies the whole thing, and if your Library is bigger, you can tell iTunes to automatically update only certain Playlists. If 
this automatic stuff isn’t for you, don’t fret. There is a way to keep total control over what goes onto your iPod.

It’s called manual updating. Connect your iPod to your PC/Mac, select it in the source list and look for the Summary Tab.

Quickly add songs from CDs to Playlists

An easy way to add individual songs from a CD to a Playlist is to simply drag them from the CD track list to the desired 
Playlist in the Source list. iTunes will automatically import them and add them to your Library and to the Playlist. If you 
want the song to appear in a new Playlist, simply drag it to an unoccupied area in the Source list.

Simply click the checkbox next to Manually manage music 
and videos and you’ll be up and running. You can now drag 
any song or Playlist you want to and from the iPod, and you 
can also play songs directly from the iPod that may not be 
present on your hard drive. To revert back to the ease of 
automatic life, just revisit the iPod settings and UNcheck the 
same option.

As the name of the option implies, this checkbox will only set 
manual management of your music and video (TV show and movie) content. The remaining four tabs (Podcasts, Photos, 
Contacts and Games) have their own checkboxes that let you sync or de-sync their specific types of content, with lists of 
specific content you can add in whole, in part, or not at all. This isn’t truly “manual mode,” but it’s as close as iTunes gets.

If you want to manage your podcasts manually, individual podcast episodes are treated as normal audio files, and 
can therefore be dragged to your iPod as any audio track would. However, you can still set your podcast settings to 
automatically sync new episodes even when managing the rest of your iPod content manually.
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Recover your lost iPod’s serial number (Mac)

Hopefully, you’ll never have to use this tip. But, in the event that your iPod gets lost or stolen, you’ll need its serial number 
to file a police report or possible insurance claim. If you didn’t think to write it down and you’ve since thrown away the 
box (or if you never got the box because it was a hand-me-down iPod from your big sister), you’re not out of luck - if you 
have a Mac. Navigate to your Home directory (the one you’ve named) in Mac OS X and go to Library > Preferences. Find 
and open the com.apple.iPod.plist file with any text editor and you’ll be able to spot your iPod’s serial number. If you have 
a PC, be sure to keep a copy of the serial number handy - it’s not as easy to find.

Time for a change

Is the Elapsed Time display just not doing it for you anymore? Well, click on it when you’re playing a song and it will 
change the second number to show the Remaining Time of the current track. Click it again, and the status window’s 
second number will show you the Total Time of the entire song.
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Managing your Library with checkmarks

You’re in a quandry: do you want iTunes to always transfer 
your entire collection to your iPod, or do you want to take full 
control of which songs get copied? That’s what the Automatic 
and Manual settings seem to force you to decide. But there are 
two compromises. You can put iTunes in fully automatic mode 
( “update everything” ), have it update only specific playlists, or 
ignore songs that aren’t checked - yes, the little checkmarks to 
the left in your iTunes window. To do this, select your iPod in the 
source list, and choose the option “Only sync checked items.” 
iTunes will then not copy any unchecked songs to your iPod.

Find out where a song is hangin’

If you’re creating Playlists manually, or if you have quite a few Playlists and try to keep them from having the same songs 
as another, this tip will help you out. By Right-clicking (or Mac Control-clicking) on a song, you get a contextual menu 
containing the Show in Playlist item. From here you can get a list of all the Playlists in which a single song resides. This tip 
is also handy for making mix CDs when you know you want a song on the CD but can’t remember if you already added it.

One letter answers

Ever get tired of clicking on 
seemingly endless Yes and 
No buttons in iTunes dialog 
boxes? Well, you don’t have 
to any more. Hitting the 
corresponding Y or N key will 
do the same thing without 
moving the cursor. This will 
also work in dialog boxes that 
have buttons with other labels.  
Simply press the first letter of 
the button name, for example, 
C, K or M in this dialog box.
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Keep computer-deleted files on your iPod 
 
If you automatically manage your iPod, are running out of 
computer hard drive space, and want to delete songs from 
your computer without losing them on the iPod, here’s a dirty 
little workaround. Remove the files from your hard disk, but 
do not delete them from your iTunes library. They’ll appear 
in iTunes with an ! next to their names, meaning that iTunes 
cannot find them. They will not, however, be deleted from your 
iPod when you sync automatically. If you return them to your 
iTunes Music folder later, all will be well. We don’t advise this 
tip, but it works.

Getting rid of the arrows 

By default, iTunes has a setting turned on that creates a link to the iTunes Store from the Song Name, Artist, and Album 
tags on any song you select - an improvement over past versions that loaded the whole window full of arrow links.

To get rid of these arrows, go to the Preferences menu. Under the General Tab, there is a checkbox labeled Show Links 
to the iTunes Store. Un-checking this will rid your window of the links, and of course you can always turn them back on 
later if you want.

Use an iPod with Mac OS 9

Did you know that it’s possible to use an iPod even if you’re still stuck in the dark 
ages of Mac OS 9? Yup, it’s true. Just don’t expect to be rockin’ out with a top-of-the-
line iPod (with video) - you can only use a first- or second-generation model (5, 10 
or 20GB). And since Apple no longer sells these, you’ll have to get one off eBay or 
dig up your weird friend who was buried with his original iPod in 2002 after a freak 
PowerBook battery incident. Either way, once you have your little white beauty all you’ll 
need to do is update your software. You’ll need Mac OS 9.2.1 (http://docs.info.apple.
com/article.html?artnum=120030), iTunes 2.0.4 (http://docs.info.apple.com/article.
html?artnum=120073), and iPod Software 1.3 (http://docs.info.apple.com/article.
html?artnum=120198).



183

The Free iPod Book 3.3 iTunes Tips & Tricks 
Edit song info like a pro

This is one of the best advanced keyboard tips out there - one for real iTunes pros. When editing track information for 
multiple songs, it can be a pain to keep clicking the Next button at the bottom of the Get Info window to start editing 
another song’s details. Instead, just press Control-N on PCs, Command-N on Macs to go Next, or Control/Command-P 
for the previous song. If you want to jump from tab to tab (Summary, Info, Options, Artwork) in the Get Info window, 
press Control or Command-] (bracket). Bonus: This also works for the Preferences window.

Avoid the blank CD warning

Have you ever been ready to burn a CD, inserted a blank, and gotten the annoying dialog box asking you what you 
want to do with it? To avoid this irritation, click the Burn Disc button before you insert the CD. iTunes instinctively then 
asks you to insert a blank CD. Armed with this knowledge, you’ll never have to deal with that dialog box again - in iTunes, 
at least. 
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Moving your iTunes Music folder to a different 
drive

For those with truly huge music collections, the addition of a 
separate music drive can become a necessity, especially if you 
use a laptop. iTunes is there to make sure that moving your 
Library isn’t nearly as time consuming or tedious as it sounds. 
First, open the Windows Explorer or Mac Finder. Move the 
iTunes Music folder (located on the PC at Documents and 
Settings\(yourusername)\My Documents\My Music\iTunes\
iTunes Music and on Macs at Users > (yourusername) > Music > 
iTunes) to the location you’ve selected on the new drive. 

All you have to do from there is tell iTunes where you’ve 
moved the folder. By going into Preferences and selecting 
the Advanced Tab, then the General Sub-Tab, you can click 
the Change button next to the iTunes Music location box and 
direct iTunes toward the new external home of your music 
folder. As soon as iTunes recognizes it, you can make all the 
additions and subtractions you want and they will all take 
place inside the external Music folder and not the one on your 
computer. Just be sure the drive is on when iTunes is loaded, or 
iTunes will be confused.

Sharing iTunes Store songs on multiple computers

If you’ve purchased songs from iTunes and want to hear them 
on multiple computers, you will first need to authorize the other 
computers to play music from your iTunes Store account. This can 
now be done by selecting the Authorize Computer option from the 
Store menu in iTunes 7.  You will need to enter your iTunes Store 
userid and password, and your computer will then be authorized to 
play any iTunes Store music you might want to add to it.

You will then need to actually get the music transferred from your 
main library over to your other computer. Traditionally, this would be 
done by manually copying the music files to each computer (either 
over a network, if your computers are networked, or by burning 
the music files onto CDs or DVDs - you can use a CD-RW or DVD-
RW disc for this to save plastic). While this is still an option, iTunes 7 
now offers a much cooler way to do this simply by using your iPod.  
Purchased tracks stored on an iPod can now be reverse-synced back 
to any one of your authorized iTunes computers. Simply connect 
the iPod to 
the other 
computer, 
and choose 
the option 
to “Transfer 
Purchases” 
when 
prompted.

This dialog box will only appear if you are 
automatically syncing your iPod to a different iTunes 
library. If you are managing your iPod manually, you 
can instead initiate this process by right-clicking 
the iPod in the source list and choosing “Transfer 
Purchases” from the context menu. Note that this is an 
all-or-nothing process.  iTunes does not provide any 
way to selectively transfer purchases from the iPod, 
rather all purchased content that is on the iPod that 
is not in the current iTunes library will be copied over, 
including movies, TV shows and even iPod Games, so 
you’ll want to ensure that you have lots of disk space 
for this process if you’re reverse-syncing an 80GB iPod.
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Splitting a song

Do you have any CDs with 
hidden bonus tracks? You 
know, the ones that are 
attached to another song 
via three or more minutes of 
silence? Well, there’s an easy 
built-in way to make these 
separate tracks in iTunes. First, 
select a song and Get Info on 
it by going to File > Get Info. 
In the Get Info window, click 
on Options and then set the 
Start and Stop times for the 
song. Once these are set, 
click OK, and then with the 
song still selected, go to 
Advanced > Convert 
Selection to AAC (or whatever 
your preferred format is). 
This will create a new track 
containing just the sound 
between the start and stop 
times you set. This tip is also 
useful for splitting Audiobooks 
into shorter segments.

Take your music with you 
(switching computers)

As you learned in a previous tip, 
iTunes makes it simple to change the 
location of your Music folder. iTunes 
also makes it relatively easy to move 
from one computer to another and 
take your Music Library with you. 

The first step is to locate your iTunes 
folder on your hard drive, which we 
discussed in an earlier tip. The second 
step is to copy the entire contents of 
the iTunes folder to the same spot 
on your new computer. You can do 
this via File Sharing, by burning it to 
CD or DVD (if it will fit), or by using 
our recommended Mac technique: 
FireWire Target Mode. Make sure your 
old Mac is shut down, connect it to 
the new (and running) Mac, and then 

startup the old one while holding the “T” key. This will start your old computer in Target Mode, and it should appear in the 
Finder window of the new computer. You can then drag the iTunes folder to the Music folder in your new Home directory. 
As long as you keep the iTunes Music folder in the same space - either on an external drive or in your newly copied iTunes 
folder - your fresh copy of iTunes on your new Mac should start up containing your Music Library from the old computer.
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Deauthorize your old computer

As part of the iTunes Store’s FairPlay Digital Rights 
Management system, you have to authorize a computer 
to play songs purchased with your account before you 
can actually play them. This works out fine until the day 
comes that you want to move on to the new computer 
you’ve been dreaming about. iTunes provides a way to 
deauthorize your computer, but it is important that you 
do so before you ship it out because as of right now you 
can only deauthorize a computer from the computer 
itself. Go to Store > Deauthorize Computer. This will 
deauthorize your computer for the iTunes Store account, 
but if you have an Audible account, you’ll need to 
deauthorize it separately. This option can be found under 
the Advanced > Deauthorize Audible Account option.

If you should decide to keep the computer and need to 
reauthorize it, you can either use the Store > Authorize 
Computer menu option, or simply try to play a song 
purchased with the account you deauthorized, and 
iTunes will walk you through the process of authorizing 
your machine once again. 

Make your own Celebrity Playlist with iMix

Have you ever had a Playlist you liked so much that you wanted 
to share it with others? Do you think your musical taste is ready 
for the masses? If so, Apple has a feature for you: iMix. iMix allows 
you to add any Playlist you want to the iTMS, provided the songs 
are available. Creating your iMix is easy. First, create a Playlist 
containing the songs you want in your iMix. Then either click 
the arrow button next to the Playlist’s name, or if you turned 
the buttons off, go to File > Create an iMix. From there, you’ll be 
prompted to give your iTMS account password, then be taken to a page listing how the iMix will appear to other users. 
Here you can add a description of your iMix if you want. Keep in mind that your iMix can be rated by any other user of 
the iTMS, and you can always update your iMix by publishing it again from the Playlist. 

Get tips and tricks for your iPod Games

Computer nerds have an old saying: “Are you stuck? RTM!” 
(Decoded: Read The Manual.) If you’ve been downloading iPod 
Games from the iTunes Store, you mightn’t realize that you’ve 
also received a large, scrollable instruction manual with each 
game, found in your Library under the iPod Games section. 
Select a game title and you’ll find a scroll bar off to the right 
of the iTunes window; if you haven’t tried scrolling down yet, 
you should. There are pictures and details for most games’ later 
levels, plus helpful hints on how to better control the games 
with the iPod’s Click Wheel. If you need cheat codes, check the 
Articles section of iLounge.com - we’ve posted some.
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Set tracks to save where you left off, or slow down

As you may already know, fourth- and fifth-generation iPods, minis and nanos have the ability to change the speed of 
Audiobooks. By nature, these Audiobooks also have a bookmarking feature that allows you to interrupt your “reading” 
to listen to a song, then pick up right where you left off when you switch back. These are both great features for 
Audiobooks, but it might be nice to have them for regular audio lectures and symphonies, or just to use the speed control 
to experiment with normal songs. 

Well, there is a way to do exactly that. By using a free third-party Mac utility called Quick Change, you can alter the tag 
iTunes and your iPod look at to identify the type of file. Essentially, we are using it to fool them into thinking your normal 
AAC file is one of those privileged Audiobooks. (Sorry, this part won’t work with an MP3 unless you convert it to AAC first.)

First, download and open Quick Change (everydaysoftware.net/quickchange/index.html). Next you should go to File > 
Open and find a normal file that you’d like to use the bookmarking and or speed adjust feature with. Once you have your 
file ready, all you need to do is change the text in the Type field from “M4A“ to “M4B “ (both with spaces at the end) and 
hit Save. Now iTunes and your iPod will think that song you just changed is an Audiobook. In fact, it will even appear in 
the Music > Audiobooks menu on your iPod. If you have several songs you would like to do this with, you can drag and 
drop them to the drawer below the main Quick Change window, type “M4B “ in the Type field, and hit the Batch button 
and all of the files will be changed at once.

Starting in iTunes 5, Apple added a general-purpose bookmarking feature that can be used with standard MP3 and AAC 
files: simply Get Info on your music file and check the Remember playback position box. This will let iTunes remember 
wherever you left off - a useful feature if you’ve created huge individual files that better represent complete albums than 
their individually separated tracks might. Though outdated somewhat by that addition to iTunes, iPodSoft still offers a 
$15 PC program called MarkAble (ipodsoft.com/index.php?/software/markable) that can help you create bookmarkable 
non-audiobook and non-podcast files, but you’ll really want it for its automated file-merging features, which combine 
multiple tracks into larger files with ease. Be aware: neither of these solutions will let you adjust the speed of your songs.
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Round up your favorite radio stations

One of the best things about iTunes is its huge selection of built-in Internet Radio stations. Unfortunately, this selection 
of stations is also one of the worst things about iTunes - it’s huge and you may not be able to find a station you liked after 
hearing it once. Luckily, the application quietly allows you to add your favorite stations to any Playlist. Just go through all 
the stations from time to time and when you find one you like, drag it over to a Playlist. (They’re differentiated in the 
Playlist from normal tracks by a tiny blue icon in front of the station names.) Now you can tune in super quick - sort of like 
those presets on your car radio.

Ditch the battery icon on black-and-white iPods

Okay, this isn’t an iTunes tip per se, but we had to toss it in because it’s so 
cool. The iPod battery icon isn’t the most detailed way to figure out how 
much battery life you have left. This tip shows you how to replace the icon 
of a 1G, 2G, 3G, or original mini iPod with a voltage number that is a little 
easier to gauge. (Around 500 is the maximum, give or take 20-30.) It’s not 
really a countdown timer, but it’s better than the limited iPod icons. 

To turn on the voltage meter with a Mac, use Terminal (Applications > 
Utilities in Mac OS X) and type: 

touch /Volumes/name_of_your_iPod/iPod_Control/Device/_show_voltage

To revert back to the lovely icon, type the following in Terminal:
rm /Volumes/name_of_your_iPod/iPod_Control/Device/_show_voltage

You must have your iPod connected to your Mac and enabled for Disk Use for this tip to work. And you’ll need to change 
the “name_of_your_iPod” part above to the name of your iPod.

To pull this off on a PC, go to Windows’ Tools menu (inside any Explorer window), select Folder Options, View, and Show 
Hidden Files and Folders. Also be sure you’re displaying filename extensions. Then find the iPod’s hidden iPod_Control 
folder, and the Device folder inside of that. Create an empty text file (right-click on the folder inside Windows, and 
choose New > Text Document), then rename it “_show_voltage” without the quotes, and without .txt at the end. 
That’s it. Delete this file when you want your old icon back. 
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Pre-built Smart Playlists

We’ve already shown you how to create your own Smart Playlist, so we decided to share with you the top five Smart 
Playlists that we couldn’t live without. Remember, the easiest way to create a Smart Playlist is by Shift-clicking (PC) or 
Option-clicking (Mac) the Add Playlist button. 

Unrated Songs
Great for when you have a large music library and you’re in the mood to do some rating. 
< My Rating - is less than - ★ >

Heavy Rotation
Admit it. You listen to a handful of tracks 90 percent of the time. This Smart Playlist grabs only songs with four or five stars 
that have been played within the last three days. 
< My Rating - is greater than - ★ ★ ★ > < Last Played - is in the last - 3 days >

Never Heard
Another great one for those of us with gigabytes and gigabytes of music. Chances are good that you’ll unexpectedly find 
a gem. 
< Play Count - is - 0 >

New Music
This Smart Playlist is perfect for just checking out all the latest tunes added to your collection. 
< Date Added - is in the last - 30 days >

Purchased Music
Yes, we know one of these comes with iTunes by default. But, if you happen to delete it, you’re pretty much out of luck -
iTunes will create another “Purchased Music” Playlist the next time you buy something from the iTunes Store, but it won’t 
include all of your previous purchases. 
< Kind - is - Protected AAC audio file >

Quickly queue up a song in Party Shuffle

If you consider yourself an aspiring DJ, this tip will help you play tracks 
in the Party Shuffle mode with the quickness. After you’ve created a 
Party Shuffle Playlist (just click “Party Shuffle” in the Source list) and 
are jamming to a tune, and get a requested song that you know you 
have, find it in your music library using the Search bar (top right of the 
window), Right-click (PC) or Control-click (Mac) the song, and select 
Play Next in Party Shuffle from the contextual menu. The track will 
appear in the Party Shuffle Playlist below the currently playing song and 
will be the next to play.
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iSync your iPod (Mac)

If you have a Mac running OS X 10.3 or earlier, you may already know that you can use iSync to keep your calendars, 
contacts, and other information synced between computers. But did you know that you can also use iSync to keep the 
calendars and contacts on your iPod up to date? With your iPod attached, open the iSync application. Your iPod should 
show up in the brushed metal bar in the application. Click on it, and you will get a window with options to turn on 
synchronization, sync automatically, sync contacts, and sync calendars. Under the Contacts and Calendars sections there 
are options to synchronize all or just some of either group. Once you have everything to your liking, hit Sync Now and 
your iPod will be loaded up and ready to go. Apple’s integrated this synchronization into iTunes when it runs under Mac 
OS X 10.4 Tiger, but that’s it.
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Password protecting your shared music

Sharing your music can be a great convenience, but it can also be a problem if you have music or Audiobooks that 
shouldn’t be heard by all in your house (your child listening to your Chris Rock comedy performance, for example). 
Fortunately, there is a simple setting in iTunes to keep this from being a problem. By going to iTunes > Preferences and 
then the Sharing Tab, you can select the Require password checkbox, and then type in a password only you know to 
keep wandering eyes - or ears, in this matter - out of your Library.

Formatted versus unformatted space

So you’ve turned on iTunes and discovered that your 80GB iPod doesn’t hold 80GB 
worth of data. Now you want to know why. Here’s the reason, as explained by 
iLounge’s resident rocket scientist, Jerrod Hofferth. 

“Hard drives are sold and marketed using decimal gigabytes. That is, a ‘GB’ consists 
of 1,000,000,000 bytes. However, computers interpret gigabytes in binary. To a 
computer, 1 GB equals 1,073,741,824 bytes.

The ratio of ‘actual’ to ‘marketed’ file size is the ratio of these two numbers, or roughly 
0.9313225. Therefore an X-sized (marketed) drive actually has 0.9313225*X of space 
usable to a computer.”  

Make sense? No? Well, anyway, the table here will tell you how much space you 
actually have on any given iPod. Bear in mind that Apple TV’s 40GB drive has only 
around 32.8GB of available space, thanks to some pre-installed Apple software.

80GB*0.9313225 = 74.51GB
60GB*0.9313225 = 55.88GB 
40GB*0.9313225 =37.25GB 
30GB*0.9313225 = 27.94GB 
20GB*0.9313225 = 18.6GB 
15GB*0.9313225 = 13.97GB 
10GB*0.9313225 = 9.31GB 
8GB*0.9313225 = 7.45GB
6GB*0.9313225 = 5.59GB 
5GB*0.9313225 = 4.67GB 
4GB*0.9313225 = 3.73GB 
1GB*0.9313225 = 0.93GB 
512MB*0.9313225 = 476.84MB
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Deleting your entire iTunes Library

You’ve just discovered that every one of your songs was ripped improperly, and you want to delete everything. We’ve 
been through it.

To delete your entire Library, first make sure you have backups of your songs - just in case you decide later that you 
need some of them. Then, in iTunes, click the Library icon in the Source list. Select Edit > Select All to select all your 
songs. Press the Delete key, and confirm your deletion.

Need to do the same thing for your iPod? This will depend on whether you sync your iPod manually or automatically. 
If you sync it automatically and delete your songs from the iTunes Library, the next time you connect the iPod, iTunes 
will remove all its songs; since the iTunes Library is empty, syncing simply mirrors this empty Library on the iPod. If you 
sync manually, just do the same thing as you did for the iTunes Library: connect the iPod, select all the songs on the iPod, 
then press Delete.

Save your ears with Sound Check

If your musical taste has a large range, or if you don’t like being startled by super loud songs, the Sound Check setting 
in iTunes is for you. Sound Check will automatically adjust the volume of your songs to the same level. This is especially 
handy if you’re a Shuffler and can go from Harry Connick, Jr. to Slipknot. Go to the Preferences menu and click the 
Playback Tab. Now just select the Sound Check option. In order to use this feature on your iPod, you must turn it on in 
both iTunes and on your iPod. After you’ve turned it on in iTunes, go to Settings > Sound Check on your iPod and press 
the Select button to turn it from Off to On.
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Back up your music to DVD

If you have a Library that needs serious backup capacity, and you have 
a DVD burner for your PC or Mac, you can back your music up on a DVD 
straight from iTunes. 

While this was done in prior versions of iTunes by burning to a Data CD/
DVD, iTunes 7 now offers a built-in library backup feature.  This new feature 
can be found on the File menu, under “Backup to Disc.”

Selecting this option will open up a dialog box that will take you through 
the process of backing up either your entire iTunes library, including the database and the music, or only your 
purchased content.  You can also choose to only backup those items that have been added or changed since the last 
backup.

iTunes will first prompt you to 
insert a CD or DVD, and will 
then determine how many 
discs will be required to backup 
your entire library, based on 
the capacity of the disc you 
inserted.

The first disc will contain the 
iTunes library database and as 
many media files as it will fit.  
The remaining media files will be stored on 
the remaining discs.

Restoring your iTunes library from this backup 
is as simple as starting iTunes, inserting the 
first disc of the backup, and clicking the 
“Restore” button.
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Finding bad tags with Browse mode

Previously, we showed you how to sort your music in the main window. Now, we’ll talk about Browse (control-B on PC, 
command-B on Mac). Three columns will drop down - Genre, Artist and Album. 

Clicking on a Genre will narrow your search to just Artists in the Genre, and clicking an Artist narrows the Albums to 
just those by that Artist. As you can tell from the screenshot, the Browse method can be a good way to make sure your 
Genre Tags are correct. Using this feature also helps you get a feel for the iPod navigation system, since all three are menu 
options on your iPod. 

Managing iTunes downloads

iTunes 7 now offers a built-in download manager that can be used to track the download 
progress of iTunes Store purchases, podcasts, and even iPod firmware updates (more on 
this last one later). Whenever iTunes is downloading any content from the Internet, a 
“Downloads” entry will appear in the source list under the iTunes Store, indicating the 
number of items being downloaded.  Selecting this entry from the source list will provide 
a detailed list of the items being downloaded and the progress of each.

Individual downloads can 
be paused by clicking on 
the “Pause” icon at the 
right-hand side of each 
item. iTunes will pause 
the current download and 
begin downloading the next 
item in the queue. Paused 
downloads will indicate a 
status of “Stopped” and can 
be resumed by clicking on 
the same button.

Additionally, you can drag 
and drop the entries in the 

download queue to change their order. This way you don’t have to wait for a two-hour movie to finish downloading 
before you get the latest tracks on that hot new album you just purchased. Further, if you want to pause or resume all 
of your downloads at once, you can simply click on the appropriate button in the 
bottom-right corner of the downloads window.
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Use iTunes as an alarm clock

Using the iPod as an alarm is all well and good, but 
sometimes (OK, most of the time) it’s more convenient 
to use iTunes as a wake-up call. Unfortunately, iTunes 
doesn’t have this functionality built-in, but there is a 
small, helpful, and best of all - free - application that 
provides it. Appropriately named iAlarm, it can 
be downloaded at xultrasoft.com/iAlarm/ 
(capitalization required). 

Once installed, open it up and you will see a window full 
of options. The ones we are concerned with appear at the 
very top, with a checkbox next to the iTunes label. First, 
set the time in the fields above. Once you have the time 
you want, click in the checkbox next to iTunes, and if 
desired, select a Playlist. Underneath the Playlist list box 
is a slider to set the volume for iTunes when you wake 
up. The rest of the options can be explained by rollover 
helper boxes, but it is worthwhile to know that at the 
bottom is the iTunes Sleep Timer, where you can set 
iTunes to stop playing at a certain time, and then start up 
at your set alarm time.

There’s also a free Windows PC take on the 
iTunes Alarm Clock concept called - wait for 
it - iTunes Alarm Clock (rpi.edu/~desimn/
alarmclock/). It’s not the sexiest application 
we’ve ever seen, but it’s free, and it will 
wake you up to a song of your choice at a 
time of your choosing.

Track iTunes Store Sales

If you’re writing a report for school on the popularity of the iTunes 
Store, you may want to know some of the biggest milestones in 
its history. We’ve been tracking the numbers for years, but Charles 
Gaba has posted an exhaustive chart based on Apple’s press 
releases and financial statements, breaking down sales totals as 
they were published by the company at various points in time, 
along with the size of the iTunes catalog, and average sales per 
day. Find it at www.systemshootouts.org/ipod_itunes_sales.html.
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Show any song’s location

If you’re ever using iTunes and need quick access to a selected song’s file, 
try out this tip. By Right-clicking (PC) or Control-clicking (Mac) on a song 
and selecting Show Song File or Show in Finder, you can have iTunes 
instantly bring up the song’s file in Windows or the Mac Finder. 

Copy from your iPod to your Mac

OK, OK - so Apple doesn’t really want you doing this, but 
there are ways to transfer songs from an iPod to your Mac. 
However, you’ll need a third-party application to do it. We 
recommend a program called Senuti, which can be 
downloaded at ambitiouslemon.com/senuti/. Once you have 
it installed, make sure your iPod is attached and start the 
program. It will automatically recognize the iPod and load up every song 
from the iPod’s Library as well as all of its Playlists. 

Can’t remember which song it was you needed to copy over? Senuti has 
a Play button for just that purpose. Once you have the songs you need 
selected, hit the Copy button and a window will slide down allowing you 
to pick the destination for your songs. Not only does it get the songs from the iPod and put them where you selected, 
but it reads the ID3 tags and stores the songs in the same folder structure that iTunes uses.

Another software package that is worth looking at if you ever need to do a “disaster-recovery” restore of your iPod is 
iPodRIp (thelittleappfactory.com, $15).  This tool works in much the same way as Senuti, but also provides the capability 
of rebuilding your entire iTunes library from the information on your iPod, including playlists, ratings, and play counts.



197

The Free iPod Book 3.3 iTunes Tips & Tricks 
No more crappy previews on dial-up

If you’re not using the fastest of Internet connections while doing your shopping at the iTunes Store, you might want to 
set your options so that song previews have to load completely before trying to play them. Otherwise, they might not 
sound so swell. Just open the Preferences window, and in the Store Tab select the Load complete preview before play-
ing checkbox.

Multiple iPods, one computer

So, you can’t “officially” use an iPod with more than one computer, but 
you can use more than one iPod with a single computer. Using more 
than one iPod is simpler than ever - now you just do the same thing 
you’d do if you were only using one. Connect the iPod, and it will 
show up in the source list, arranged alphabetically with your other 
iPods and media devices such as iTunes Phones and Apple TVs.

To manage each iPod, simply select it in the source pane. Each iPod 
device will have its own Summary panel and other related preferences, 
and each is managed independently of the other.

You can even sync multiple iPods and other devices simultaneously.
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Make an iTunes Store wishlist

Instead of adding all the tracks you’re lusting after to the iTunes Store’s shopping cart (and hoping you can pay your 
credit card down so you can buy them all later), you might want to create a new Playlist called “Stuff I want” (or 
something similar). Now, just drag 30-second song previews into the Playlist so you can listen to them even when 
you’re not browsing the store (you can also buy the tracks directly from this Playlist). This way, you can check them out 
whenever the mood strikes you - and weed out the ones you can live without.

Capturing the Visualizer

If you have a Visual that you particularly like and would like to use as a desktop background or in a presentation, there is 
an easy way to do it. You need to have the Visualizer running in Full Screen mode for this tip to work. Once it’s on, and 
the Visual you want to capture is on screen, use the PC’s Print Screen button or the Mac’s Command-Shift-3 Keyboard 
command to take a Screenshot. On the Mac, your Visual will be saved as a Picture file on your desktop. On the PC, the 
screenshot will be sitting in your Clipboard, and you can paste it into a graphics editor or a mail message. These shortcuts 
work at any time, not just in iTunes.
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Copy from your iPod to your PC

While there are many third-party programs that perform iPod-to-PC transfers (and you can find virtually all of them 
found in iLounge.com’s Downloads section), we’ll take a look at Music Rescue (formerly PodUtil) here - a €10 Shareware 
program which offers powerful copy features and iTunes playlist regeneration. It works on PCs and Macs, just in case you 
want an option other than Senuti.

Start on the computer you want to use as an iPod receiving station, and make sure iTunes is installed. Then download 
Music Rescue (kennettnet.co.uk/musicrescue/), and install it on your PC. Next, connect your iPod to your computer with 
one of Apple’s cables. Whatever you do, CLICK NO if and when iTunes asks you whether you want to delete the content 
on your iPod. And ensure that Enable Disk Use is selected for your iPod in the iTunes Preferences iPod Tab.

Now launch Music Rescue. It will detect your iPod, examine its 
database, and display a list of all of your tracks in the main window, 
with a listing of your playlists on the left. In this window, you can 
search for tracks (in the top right corner) or preview them straight off 
of the iPod by double clicking on one.

To prepare for the music copying process, you’ll need to make a few 
choices. At the bottom of the main Music Rescue window, pick the 
computer directory where it should dump iPod music. Then, at 
the bottom right of the main window, hit the Copy Settings button. 
PodUtil can create separate subdirectories for each Artist and Album 
in your collection if you select these two options. If you turn on the 
additional iTunes features, Music Rescue will automatically add the 
copied songs to your library and recreate your iTunes playlists -- two 
helpful features when restoring lost libraries.

Next, de-select the songs (either in the main track list or in 
individual playlists) that you don’t want to transfer to the 
computer. When only the correct tracks are selected, click Copy in the 
bottom right of the main window to begin the process!

When the upload is complete, you’ll have a directory (or, if you 
selected the appropriate options, an iTunes Library) full of your iPod 
music. With only a few button clicks, you have now transferred your 
iPod’s entire music library to your computer. 

Other software packages that are worth looking at if you ever need 
to do a “disaster-recovery” restore of your iPod are CopyPod (Windows 
only, copypod.net) and iPodRIp (Mac and Windows, thelittleappfactory.com).  Both of these tools work in much the same 
way as PodUtil, but also provide the capability of rebuilding your entire iTunes library from the information on your iPod, 
including playlists, ratings, and playcounts.

Play songs on your iPod from other digital music stores

OK, so there isn’t some secret trick that allows you to use your iPod to play songs that you’ve downloaded from those 
“other” online music stores such as Napster, Musicmatch, and RealNetworks. There is, however, a dirty workaround. 
Using software that actually plays the store’s music, burn it to a CD. Then rip the tracks with iTunes in unprotected 
AAC or MP3 format, which iTunes and iPod can handle. That’s it. You can also apply this tip to the protected AAC songs 
from the iTunes Store if you want to use your purchased music on other players like the Sony Network Walkman, assum-
ing you’re looking for laughs.
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Be a protective parent

So your son or daughter has an iPod and you’re concerned that the “explicit” version of Chamillionaire & Krayzie Bone’s 
Ridin’ will wind up being downloaded and played ad nauseum at upcoming slumber parties. Thank goodness for the new 
Parental Tab in iTunes Preferences, which has three key features: a way to lock down parts of iTunes so that your kids won’t 
see them at all, a feature that prevents kids from hearing, buying, or subscribing to anything marked explicit, and a lock. 

The picture below pretty much says it all about how these various restrictions work - just remember to click the lock icon 
when you’re finished checking boxes. iTunes will ask you to enter a password, and once you’ve clicked OK, you’ll have to 
enter it again on the Parental Tab to change the restrictions. Without the lock, restrictions can be removed with ease.

Note as well that as of iTunes 7.1, you can now also specify rating restrictions for several other countries in which the 
iTunes Store is available. While movie and TV show content is not yet available from the iTunes Store in these countries, 
this feature has presumably been added to provide for future availability. If parental restrictions are being configured based 
on rating, it will probably be necessary to ensure that you select the ratings that apply to your particular country.
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Shuffle, a little less random (Smart Shuffle)

No single playback feature in iTunes has inspired more discussion than Shuffle mode - a randomized play mode that 
numerous journalists swore up and down was intelligently choosing good or bad songs. Perhaps amused by all the claims, 
Apple added a new feature to the Playback Tab of iTunes Preferences: Smart Shuffle, which will pick songs at random, then 
either try to clump together tracks from the same artist or album, or actively work to avoid clumping together such songs. 
Leaving the feature on “random” avoids sorting; “more likely” creates similar clumps, and “less likely” avoids them. 

You’ll also find three Shuffle options below the Smart Shuffle slider: “Songs,” “(Complete) Albums,” and “Groupings.” Pick 
Songs to have iTunes randomly play back individual tracks from the Library or Playlist on screen, Albums to randomly 
choose an entire album to play back before moving to the next one, and Groupings for the collected movements of 
classical works. Your Shuffle settings won’t be activated until you press the second button on the bottom left of the iTunes 
window, shown below in blue.

Ready your videos for the iPod or Apple TV

Surprisingly, iTunes can store virtually any type of video you have on your computer, 
but unfortunately, iPods and Apple TVs can’t play most of them back... unless you use 
a conversion feature hidden in iTunes. It appears whenever you select a video file, 
unless the file’s protected and from the iTunes Store, in which case you’ll get a Convert 
Selection to MP3 or AAC option, which oddly won’t work.

For unprotected video files, select the file, and either right click (PC) or command 
click (Mac) to bring up a Convert Selection for iPod option. You can also find it under 
the Advanced menu at the top of your screen (Mac) or iTunes window (PC). Click it, and 
iTunes will quietly chug away until the video has been fully converted, allowing you to 
do other things while it works. A brand new option, Convert Selection for Apple TV, 
will create high-resolution, Apple TV-ready videos if provided the right source materials 
(such as HD home movies or trailers), but you’ll need to re-convert them for the iPod.
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Use multiple separate iTunes libraries on one computer

Sure, one copy of iTunes can easily supply music to two different iPods, but when two users have significantly different 
musical tastes, wouldn’t it be less frustrating to simply use entirely separate libraries on the same computer? You can!

The easiest way to do this is to create multiple operating system user accounts, since iTunes gives each user on a computer 
a clean, distinct library by default. With this method, you have the added bonus that your desktop settings, eMail, and 
internet bookmarks are also distinct. On a Mac, users are managed in the “Accounts” panel of System Preferences. On a 
Windows machine, look for the “User Accounts” control panel to create a new user.

Another alternative if you don’t want to use separate user accounts just to have multiple iTunes libraries is to use a new 
feature in iTunes 7 that allows you to choose an alternate iTunes library at startup.  To do this, simply hold down the SHIFT 
key (on Windows) or OPT key (on a Mac) while starting iTunes. Many of your iTunes preferences will still be shared between 
both libraries, including the iTunes Music Folder location, so this is not as clean as using a completely different operating 
system user account, but it will work for people who simply want to maintain different playlists, ratings and playcounts.

Deauthorize all computers on an iTunes account

Ever sell a computer, or had one die on you before you could properly deauthorize it from your iTunes Store account? 
Frustrated because you’ve reached your maximum allotment of authorizations, and you physically can’t fix the problem?

No worries - once a year, Apple allows you to remotely deauthorize all computers associated with your account. To do so, 
access your account information page in the iTunes Store by clicking on your AppleID in the top right of the window, 
and clicking the “Deauthorize All” button. You’ll then be able to authorize a new set of computers, starting fresh.



203

The Free iPod Book 3.3 iTunes Tips & Tricks 
Tag TV Shows and Music Videos properly

Have TV Shows or Music Videos that you didn’t get from the iTunes Store? Chances are, you’ve found that iTunes won’t let 
you edit all the data fields you need to populate in order for the files to properly organize themselves in the iPod’s menu 
system. While iTunes 7 has improved on this slightly by providing a few of the more strictly required fields in the new 
“Video” tab, it still lacks the ability to change these tags for more than one item at a time, as well as lacking a way to edit 
some of the more advanced tags like description and content rating.

The good news is that there are third-party programs that make up for these deficiencies. Mac users can download 
“Lostify” (http://lowellstewart.com/lostify/about/, Free) and Windows users can try “TV Tagger” (http://tvtagger.wordpress.
com/, Free).  Either of these programs allow you to easily add data to iTunes fields such as description, rating, and more, 
as well as allowing bulk changes to multiple items at once. Simply use these programs on the raw TV Show files before 
importing them into iTunes, and the data will be properly populated in iTunes’ lists. 

Use Airport Express with other audio applications

Sure, the Airport Express is an awesome solution for easy streaming of audio from iTunes to a set of nice speakers, but if you 
want to use Windows Media Player, watch a DVD, or play a game on your computer and stream the audio to your expensive 
stereo, you’ll find that you can’t do so with Apple’s solution.

Rogue Amoeba (rogueamoeba.com/) has created an application called Airfoil ($25, available for both Mac and Windows) 
that allows you to do use the Airport Express with any application you’d like. Additionally, like recent versions of iTunes, 
Airfoil has the capability to simultaneously stream to multiple Airport Express units.
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Tidy up iTunes’ Source column

Have way too many playlists in your iTunes’ Source column? Save some vertical space by grouping them into collapsible 
folders. To create a new playlist folder, simply choose “File > New Folder” from iTunes’ menu bar. Then, simply drag-and-
drop playlists into these folders, and collapse the folders you use least.

Serious users can even create sub-folders inside other folders, several layers deep.

Unfortunately, playlist folder hierarchy does not transfer to the iPod’s playlist browsing function: 
all playlists and folders will still appear in a flat list.

When cleaning up your “Source” list, you’ll also find it restrictive that you can’t sort your playlists 
manually. iTunes’ only playlist sorting method is alphabetical: folders first, then smart playlists, 
with manual playlists grouped below. To get around this, add miscellaneous characters before the titles of the playlists 
you’d like to force to the top. For example, our “Forgotten Favorites” playlist appears at the top of the list when titled 
“+Forgotten Favorites.” This trick does transfer to the iPod, and can be further manipulated by using additional characters.

Print CD jewel case inserts and library listings

Sure, iPods are wonderful, but there are still plenty of reasons 
to burn CDs like backups, sharing with others, or playing music 
in cars that only have CD decks. Whenever we have to burn an 
audio CD, we enjoy using iTunes’ ability to print professional-
looking jewel case inserts. Didn’t know it had one? Not 
many people do - it’s a poorly-publicized but incredibly well-
executed iTunes feature. While you’re waiting for an audio CD 
to finish writing, select the playlist that you’ve burned, and 
choose “File > Print” from iTunes’ menu bar.

When burning “Data CD” or “Data DVD” backups of 
your library, use same trick, except choose to print an 
“Album listing” instead of a “CD jewel case insert,” and 
store it alongside your DVD archive, so that later on, 
you’ll be sure of what you’ve saved.

Find free iTunes Store downloads

Since early 2006, iLounge Discussion Forum Moderator Audrey 
McGirt has been tracking free iTunes Store TV downloads in a 
popular thread called FREE iTMS TV Shows Available (forums.
ilounge.com/showthread.php?t=160271). Recently, a site called 
Get Free iTunes Store Downloads (www.itsfreedownloads.com) 
popped up with the same idea, but also tracks music, book, 
and game downloads. It’s easy to check the site once in a while 
and find a bunch of decent freebies to stuff on your iPod. Apple 
maintains a page called Free on iTunes at phobos.apple.com/
WebObjects/MZStore.woa/wa/viewRoom?fcId=188575542.
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Pick a Video’s Poster Frame

When a video is purchased from the iTunes Store, it comes with either a thumbnail image of a certain frame taken from the 
video, or another piece of cover artwork. This “poster frame” is displayed in the thumbnail view of iTunes’ video browser, or 
on the iPod during video-out playback. If you’d prefer to use a different frame of the video - or another image altogether - 
as the poster frame, iTunes will allow you to do so. This is especially handy for videos not purchased through iTunes.

To set the poster frame from the video itself, simply play the video, pause it, and scrub to the frame you’d like to 
highlight. Then, right click on the video’s image, and select “Set Poster Frame.”

To use any other image, simply highlight the video, select “Get Info” from iTunes’ “Edit” menu, and drag the image into the 
box that’s in the “Artwork” tab (just as you would to apply album artwork to music).

Correct corrupt iPod album art

Has your iPod suddenly become 
confused as to which album artwork 
images belong with which songs in 
your music library? If you’re sure the 
artwork is properly set up in iTunes, 
then your iPod’s album artwork 
database is probably corrupted. It’s a 
fairly common problem, but it’s also 
generally easily fixed.

To recreate the iPod’s album artwork 
database, select your iPod in the 
Source list, and find the “Display 
album artwork on your iPod” option 
under the Music Tab. Simply uncheck 
this option, then click “Apply” to sync the iPod. This will remove all 
existing artwork from the iPod, and you can then put it back on during 
the next sync by simply rechecking this option and choosing “Apply” 
button again. A freshly optimized set of album artwork will be created 
on your iPod, hopefully fixing any album art errors.
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Keep Compilations together

Ever imported a movie soundtrack or “Best of the 80’s” CD into iTunes, only to find that its tracks have been littered all over 
your library since the songs all belong to different artists? iTunes and the iPod have a set of features that can help with 
these “Compilation” albums.

First, it’s necessary to manually inform iTunes that all tracks on such an album are 
“Part of a compilation.”  To do so, select all the tracks on the album (either when 
importing it, or later), and choose “Get Info” from iTunes’ “Edit” menu. Then, 
check the “Part of a compilation” 
checkbox, and click OK.

Next, change the way iTunes 
handles the songs by going to 
iTunes Preferences, and ensuring 
that the “Group compilations when 
browsing” option is checked. This 
will make Compilations appear in 
a separate category when you use 
iTunes’ browse mode.

You can make a 5th generation iPod or iPod nano group compilations 
together, as well. On the iPod, navigate to “Settings” and toggle “Compilations” 
to “On.” A new “Compilations” sub-menu will appear underneath the “Music” 
menu, alongside “Artists,” “Songs,” and “Playlists.”

Delete songs from within a playlist

Ever find yourself deep into playlist manipulation, when you come across a song inside a playlist that you’d like to see 
purged from your library for good? You’ve probably found that the delete key does no good, here -- in a smart playlist, it 
does nothing, and in a manual playlist, the song is simply removed from the list, not your library and hard drive as well.

The fix? To delete a song from your library and hard drive from within a playlist, hold the Option key (Mac) or Shift key (PC) 
as you press the Delete or Backspace key. This will give you the usual “Are you sure?” prompt, allowing you to delete the 
song from the playlist, your library, and your computer’s hard drive simultaneously -- with the convenience of not having to 
leave the playlist view.

Be careful, though - these same key combinations also serve to delete a playlist and all songs that it contains (!) if you have 
a playlist selected in the source column instead of a song.
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Give presentations from an iPod

Sure, you knew you could give photo slideshows from an iPod photo or fifth-generation iPod, but did you know you can 
use these devices to give a slide presentation without a computer? Connect your iPod to a TV or projector using an Apple 
iPod AV Cable, and you have a presentation machine the size of a deck of cards.

How does one get a presentation into the iPod? Simple: 
use the “Export” functionality built into either Microsoft’s 
PowerPoint or Apple’s Keynote software to create a set 
of high-quality JPG images, and then add the set to 
your iPod using iTunes’ standard photo synchronization 
functionality.

Be aware that the iPod only outputs fairly low resolution 
images to the external display, so even if you’re using a 
high-resolution projector, you may get fuzzy text. The 
larger your text, the better it will look. Experiment with your 
equipment and fonts to find an acceptable font size.

Check/uncheck multiple tracks at once

If you use the checkboxes next to each track in 
iTunes in order to control your iPod’s contents or to 
manipulate smart playlists, you’ve probably found that 

Luckily, multiple check-boxes can be toggled 
at once. Simply hold down the Command key 
(on a Mac) or the Control key (on a PC) while 
clicking any single box in a playlist. The entire 
playlist’s checkboxes will be toggled.

Be careful, though. This will simultaneously 
toggle the checked status of all songs in the 
current playlist. If you do this while looking at 
your entire “Library,” you may accidentally lose a 
lot of checked status information, and you can’t 
“Undo” it. Always mass-check or mass-uncheck 
in a special playlist, even if you have to create 
one temporarily just for this purpose.
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Enhance iTunes with helpful AppleScripts: 
Mac

Ever find a task that’s difficult, cumbersome, or even 
impossible to do in iTunes’ interface as it stands? Worry 
not, Mac users - Apple has provided a very powerful 
back way into iTunes, and developers have been taking 
advantage of it like crazy. The tool is called AppleScript, 
and though it’s been built into most Mac applications in 
over a decade, it’s never been as useful as it has recently 
been for iTunes. We can’t even begin to describe how 
useful and versatile AppleScripts can be to mac users. 

Here are a few of our favorites AppleScripts from the 
absolute best source for iTunes AppleScripts on the Mac 
web: “Doug’s AppleScripts for iTunes” (www.dougscripts.
com):

Needle Drop: This AppleScript plays every track in a 
playlist (or your library) for only a few seconds, quickly 
moving on to the next. How is this useful? Use it in 
conjunction with a Lyrics- or Artwork-fetching Widget, 
and populate your library with lots of data, with only a 
few clicks to get things rolling.

Not in Any Playlist: As its name suggests, this script 
finds songs in your library which have not yet been 
added to any playlist. A similar script will find songs 
without Lyrics. 

Tracks without Artwork to Playlist: Commonly 
requested by our Ask iLounge readers, this script locates 
songs which don’t yet have album artwork, and puts 
them in a playlist. This is especially handy since Apple 
still hasn’t included “Has Artwork” as a smart playlist 
condition.

Join Together: Ever want to keep an album together 
to avoid gaps during playback (Dark Side of the Moon, 
anyone?), but don’t want to lose the ability to skip to a 
certain track? Use this amazing script to join an album’s 
worth of tracks into one, and preserve track marks as 
iTunes Chapters, like those used in enhanced podcasts.

Installation and usage for each of these scripts is 
potentially different, but in most cases, you’ll download 
AppleScripts and place them in your “/username/Library/
iTunes/Scripts” folder, which will create a shortcut to 
them directly within iTunes’ own menu bar.

We truly regret that we don’t have more space to 
highlight more of Doug’s amazing script library in this 
edition of the Free iPod Book, but we encourage you 
to head on over to “Doug’s AppleScripts for iTunes” and 
check them out for yourself!
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Enhance iTunes with helpful JavaScripts: PC

PC users: impressed with the previous hint regarding AppleScripts? While Windows-based iTunes users don’t have 
nearly the same selection of iTunes-enhancing scripts, don’t worry - you haven’t been completely abandoned. On this 
platform, there’s JavaScript, and a few developers have begun to use it. To get yourself started, browse to ottodestruct.
com/blog/tag/itunes and try out some of these scripts below, and more:

No Art Playlist / No Lyrics Playlist: These scripts create a playlist of all songs in the library without artwork or lyrics.

One Hit Wonders: Here’s a fun one: this creates a playlist of all songs in the library for which they are the only song by 
that artist.

Find Dead Tracks / Remove Dead Tracks: Ever been surprised by those annoying exclamation points next to songs 
that iTunes can’t locate? These scripts seek out, and optionally delete from your library, these songs which iTunes can’t 
find anymore.

Explicit Lyrics: This handy script will search out songs which have “bad words” (customizable) in their lyrics fields, and 
places the word “Explicit” in their “Comments” fields. Neat!

Continue interrupted iTunes Store downloads

It’s happened to all of us: you’re in the middle of 
downloading an album of music, season of TV shows, or a 
shopping cart full of singles, and your internet connection 
dies. In such a case, there’s no need to worry, or even to 
contact iTunes Support. Instead, simply choose “Check for 
Purchases” from iTunes’ “Store” menu - it works like a charm 
to restart unfinished downloads.

Review previous iTunes Store purchases

Need to track down a previous iTunes Store invoice? Want to shock yourself - just for kicks - with how much you’ve spent 
on legal downloads since iTunes’ debut? Apple makes it easy. Log into the iTunes Store, click on your Account bubble 
in the top-right corner, and click “Purchase History” in the list of options. Here, you’ll be able to see the full detail of 
any purchase you’ve made. 
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Use alternate visualizers in iTunes

Tired of iTunes’ current visualizer software? Get a new one! There are plenty of free and shareware visualizers available 
as plug-ins to iTunes. Our current favorites, available for both the PC and Mac, are G-Force and WhiteCap, both available 
from SoundSpectrum (http://www.soundspectrum.com/). They’re both gorgeous and infinitely customizable. A new 
visualizer, SoftSkies, is also available in free form from the site; SoundSpectrum now sells premium versions for $20-30.
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Limit your iPod’s and iTunes’ output volume

Worried about damaging your ears by listening to your iPod? You should be, and Apple agrees: in addition to the Sound 
Check feature of iTunes, which brings all songs to the same volume level, the company has created a Volume Limit 
feature for users of updated 5th generation and nano iPods. The feature is extremely easy to use, and also gives parents 
the ability to pre-determine a safe listening level for their kids, using the iPod’s previously developed Screen Lock 
feature to lock that level in place.

Using Volume Limit is easy. Select Settings from the iPod’s main menu, and you’ll see an option called Volume Limit. 
Then, simply slide the triangle to your new maximum, and press the center button. Then, the iPod will bring up a 
screen enabling you to set a four-digit combination code that will prevent other users from changing the volume 
cap. If you don’t want to set a code, choose Done. In either case, you’ll quickly notice a subtle change to the iPod’s 
volume operation: the new maximum simply isn’t as loud as before, and the volume bar terminates in a “Lock” icon.

Be aware: different headphones and different songs have different maximum volume levels, so set the limit with the 
same headphones and songs you’re concerned about. Also, most bottom-mounting accessories, such as third-party 
(non-Apple) remote controls, will not support the volume cap.

For the iPod shuffle, since there is 
no screen or other user interface on 
the device itself from which to set 
a volume limit, this is instead done 
through iTunes. Simply connect the 
iPod shuffle to your computer, and 
you can find the “Limit maximum 
volume” setting on the Shuffle’s 
“Settings” tab. Enable it, set an 
appropriate volume level, and then 
click the lock icon to password-
protect the setting so it can’t easily 
be changed. 
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Play the songs you want with double Smart Playlists

Our Ask iLounge column frequently receives questions from readers asking how to create some fairly complex smart 
playlists. Some appear simple at first, yet their needs can’t be satisfied by a single smart playlist. For example, a playlist 
collecting all unplayed tracks from either the “Rock” or “Alternative” genres cannot be created in one playlist since its logic 
contains both OR commands (the genres) and AND commands (Play count = 0). But it can be done with multiple playlists.

Begin by creating an intermediate playlist called “Rock or Alternative” that specifies the genre selection, making sure 
that you’ve selected to “Match any of the 
following rules”:

Then, create a second smart playlist - the 
one we’ll actually listen to - and make sure 
that it requires that songs are both present 
in our intermediate playlist, AND have a Play 
count of 0. 

Such multi-playlist logic schemes can get 
very complex and very fun - experiment, 
and see what you can come up with!

Listen to your iPod through computer speakers

Most iPod users synchronize with an iTunes library at home, and take their iPods into work. Many Ask iLounge readers who 
operate in this way want to play the iPod’s directly through their work computer’s speakers, instead of trying to maintain 
updated iTunes libraries both at work and at home.
If you synchronize your iPod at home using “Automatic” synchronization mode, you’ll find that your work PC’s iTunes 
doesn’t allow you to play a connected iPod’s tracks - they’re “greyed out” and completely inaccessible. However, if you 

change the iPod to manual synchronization 
mode, the greyed-out tracks become accessible 
again, and you’re able to listen to any track directly 
off the iPod, using iTunes’ excellent browsing 
interface. 

To change this setting, select your iPod in the 
source list and select the option to “Manually 
manage music and videos.”

Enjoy listening to your music at work, and change 
the synchronization settings back to how you 
really want them once you get back home. As an 
added bonus, iTunes will even update ratings, play 
counts, and last played times on your connected 
iPod, so when you get back home and switch 
back to “manual” mode, this information will be 
updated in your main iTunes library.
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Create your own stripped-down iPod interface for kids

If you’re a parent of young children, a school administrator, or just a nervous iPod loaner, you’ll love the iPod’s much 
underdiscussed “Museum Mode,” which (among many other things) allows an iPod’s owner to create an incredibly 
simple iPod menu interface, and preventing all but a select few options from being accessed at all.

For example, we can create an iPod interface a parent would love: only a few kid-friendly movie soundtracks will be 
accessible from the iPod’s controls - there will be no “Music” browsing, “Photos” browsing, “Videos,” “Settings,” or any 
other standard iPod menu options -- only what we explicitly specify.

First, we need to create the menu. Create a text file called “Main.linx,” and store it in the “Notes” folder on your iPod’s 
hard drive. It should look something like this; you change the links to match the tags of the music you’d like to link to:

<TITLE>iPod: Kid Mode</TITLE>
<A HREF=”ipod:music?album=Curious George (OST)”>Curious George Soundtrack</A>
<A HREF=”ipod:music?album=Lion King (OST)”>Lion King Soundtrack</A>
<A HREF=”ipod:music?album=Toy Story (OST)”>Toy Story Soundtrack</A>
<A HREF=”ipod:music?artist=Sesame Street”>Sesame Street Songs</A>
<A HREF=”ipod:music?playlist=Kid Tunes”>Kid Mix</A>

Next, create a text file which contains only the following line:

<meta name=”NotesOnly” content=”true”>
 
Save this file as “Preferences” (no file extension) and store it in your iPod’s “Notes” folder. Eject your iPod, reset it, 
and you should be presented with only your limited interface, with no way out. To re-enable access to your iPod’s 
default interface, simply reconnect the iPod to a computer, move these two files out of the Notes directory, and keep 
them somewhere safe (the iPod’s root directory is fine) until you need them again. No reloading of the iPod is necessary 
since you’re not deleting anything, only limiting access.

Add a keyboard shortcut for the Equalizer (Mac)

Experienced iTunes users will notice that iTunes 7 has not only eliminated 
the equalizer button, but has also taken away the keyboard shortcut 

for whatever 
reason. But Mac 
users can easily 
assign a keyboard 
shortcut back to the 
equalizer option via 
System Preferences. 
Simply go into the 
“Keyboard & Mouse” preference, and 
choose Keyboard shortcuts. 

Click the plus sign to add a new keyboard 
shortcut, and select iTunes as the 
application and ensure that you enter the 
exact name of the menu option (ie, “Show 
Equalizer”) and then press the key you 
want to assign to it. 

Once you save these preferences and then restart iTunes, you’ll see your new shortcut listed on 
the “View” menu beside the “Show Equalizer” option.
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Add Album Artwork automatically

With iTunes 7, Apple has now chosen to make its entire catalog of iTunes Store 
album artwork available to users who have acquired their music albums from 
other sources such as their own CD libraries.

Although the album artwork itself is provided by Apple at no charge, you will need 
to have a valid iTunes Store account in order to use this feature, since it requires 
access to the iTunes Store.

To download artwork for a specific track or set of tracks, simply right-click on 
the track and choose “Get Album Artwork” from the context menu.

Alternatively, if you simply want to let iTunes go out 
and find the missing artwork for you automatically, you 
can enable the necessary option in iTunes General 
preferences. iTunes will ask you to confirm that this is 
in fact what you want to do, and provide a reassuring 
disclaimer that it’s not in fact secretly collecting data on your music listening habits.

A more colorful way to look at iPod capacity

In the Summary for each connected iPod, iTunes now provides a more colorful representation of exactly what is stored on 
your iPod, broken down by Audio, Video, Photos, and Other content. 

You may notice that the Audio bar actually contains 
two different shades of blue. The darker shade of 
blue actually represents the space taken up by Music 
Videos, which are treated as part of your music 
library for this purpose, rather than as video content. 
The purple video section includes only Movies, TV Shows, and Video Podcasts.

The “Other” category is frequently the source of much confusion from iTunes users, since it really consists of anything 
and everything on your iPod that doesn’t fit into one of the other three categories. This includes the iPod’s own internal 
operating files and databases, album artwork, iPod Games, calendar and contact data, iPod notes, and files transferred in 
“disk mode.”

Don’t be alarmed if your “Other” storage looks a bit 
high.On a full 80GB iPod with album artwork and the 
full set of iPod Games, this category can reach 2GB.   
One neat hidden feature: clicking on the capacity 
bar itself will toggle the numeric counts between 
storage space, number of items, and duration.
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Smarter Playlists for TV Shows

iTunes provides some basic options for controlling 
the synchronization of TV shows in the iPod and 
Apple TV sync preferences, but one of the problems 
with this built-in synchronization feature is that there 
is no setting for oldest episode. Since most people 
generally prefer to watch a TV series in order from the 
first episode onwards, a Smart Playlist can be used to 
effectively select a group of unwatched episodes to add 
to your iPod so you can continue to watch fresh episodes 
of your favorite show.

Simply set up a series of smart playlists like the one above for 
each of your favorite shows, and then set your iPod or Apple TV to 
sync these playlists, rather than specified shows. As episodes are 
watched, the smart playlists will automatically refresh the iPod or 
Apple TV with the next shows in sequence.

Keeping track of your Music Videos

As of iTunes 7, Apple has taken the approach that music videos are an extension of your music library, and removed the 
separate category for music videos, instead choosing to organize them alongside your normal music tracks. As a result of 
this approach, you’ll find the music videos listed under the “Music” section in iTunes, organized by artist and album, listed 
among your song tracks. If you want to get a list of all of your music videos, the simplest way to do this is to use a smart 
playlist for them. As of iTunes 7.1, this playlist is automatically created as one of the default playlists in a NEW iTunes 
library. However, if you’ve upgraded your library from any previous version you will need to create this playlist manually.

To create a Smart Playlist, simply choose New Smart Playlist from the File menu in iTunes. You will be presented with a 
dialog box asking you to specify what criteria you want to apply to the smart playlist in question. A simple criteria of 
“Video Kind” is “Music Video” should suffice if you simply want to organize all of your music videos in one place, although 
you can certainly specify any additional criteria if you wanted to limit the selection further (perhaps creating music video 
lists for different genres or eras, for instance).

Note as well that once you have created the 
smart playlist, you can manage your videos 
and further organize them from within 
that smart playlist. For instance, the normal 
“Browser” function works within any playlist 
as well, so you can quickly and easily filter 
by genre, artist, or album when browsing 
your “Music Videos” smart playlist. You can 
delete tracks from your library directly 
from within the smart playlist by holding 
down the SHIFT key (Windows) or OPT key 
(Mac) while pressing the DELETE key.
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Going with the (Cover) Flow

One of the very cool new features in iTunes 7 is the 
Cover Flow view for browsing through your music or 
video library by album cover, rather than a boring list 
of track names. To select the Cover Flow view, simply 
choose the third button from among the “View” 
buttons in the top-right corner of the iTunes window. 

Apple has also added a full-screen Cover 
Flow mode, which looks much like the 
iPhone’s album display feature, yet has the 
resolution to look absolutely stunning on 
a Cinema Display or home entertainment 
system. It provides a neat way to let 

your guests browse through your 
music at a party. To access the full-
screen view, simply click the “Full 
Screen” button that appears on the 
windowed Cover Flow view.

You can then flip through your music 
albums electronically in much the same 
way you would have once flipped through 
your CDs, and can even play an album 
right from the full-screen view with the 
provided buttons. Expect it to evolve.
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Change photo sync order

When syncing photos to newer iPod models (and the Apple TV), 
they sync by default in whatever order your folders or iPhoto/
Aperture albums are listed in. This may or may not be practical, 
and the good news is that you can change this order just by 
choosing selected albums and dragging and dropping the items 
in the list.

Simply highlight the item you want to move to a different 
position, and then drag it up or down the list to its new position 
and drop it there. Click ‘Apply’ and iTunes will happily sync the 
new order to your iPod or Apple TV.

Burning smarter CDs with CD Text

iTunes 7 now provides the ability to burn audio CDs with CD-Text included, 
assuming that you’re using a supported CD recorder. The CD-Text standard allows 
supported CD players to display song track information while playing back a CD. 
The information in the iTunes database is used to generate the CD text, and any 
supported player with the CD-Text logo should be able to display information 
on which tracks are playing when the CD is inserted. Also, since iTunes can 
also read CD-Text from a support CD-ROM drive, this information can be used 
instead of the normal CDDB lookup to fill in track information. Just enter iTunes 
Preferences, pick the Advanced Tab, the Burning Sub-Tab, and check the 
Include CD Text box. That’s it.

Updating or Restoring your iPod

Prior to iTunes 7, updating or restoring the iPod was handled through 
a separate tool, the iPod Updater Utility. With iTunes 7, these functions 
have been integrated into iTunes itself. Found in the Source list (the 
left-most column of your iTunes window) under Devices, the iPod 
Summary screen in iTunes now shows the current version of the 
iPod software, and provides buttons to either Update the iPod to the 
newest available (if a newer one is available), or to Restore the iPod 
back to factory settings. Use this if your iPod’s become slow or buggy.
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Understanding iTunes Plus: High-Quality, No-DRM Music

Only one new feature was conspicuously added to Apple’s iTunes 7.2 
software in late May, 2007: support for enhanced “iTunes Plus” music 
downloads, the result of deals worked out by Apple, the music label EMI, 
and certain independent music labels.

Until May 30, 2007, all music downloads from the iTunes Store were 
digitally protected against copying, and sold in the acceptable but not 
outstanding 128Kbps AAC format. Users with excellent ears and earphones 
complained that these iTunes downloads weren’t up to the standards 
of CD quality, and noted that there was no reason besides convenience 
to prefer downloading copy-protected songs and albums to purchased 
unprotected, higher-quality CDs from online or local stores. With iTunes 
Plus, Apple is attempting to eliminate these concerns, offering higher-
quality songs without copy protection - at a slightly higher price.

iTunes Plus music tracks are described by iTunes as 256Kbps Purchased 
AAC files rather than 128Kbps Protected AAC files. As that suggests, the 
new iTunes Plus tracks aren’t guarded by Apple’s FairPlay digital rights 
management (DRM) system, so you can copy them freely from computer 
to computer, and AAC-compatible device to device, without worrying 
about whether they’ll play. Apple still tags each download with your 
name and e-mail address, most likely to discourage rampant copying. 
Higher quality demands larger files: new tracks require roughly twice 
as much space as old ones, so the more iTunes Plus music you have, the 
fewer songs will fit on your iPod. There are also iTunes Plus Music Videos, 
which remain at the prior price, but offer superior (256Kbps) audio, and 
increase less in size as the video portion’s the same.

Identifying iTunes Plus Songs and Albums

When you visit the iTunes Plus section of the iTunes Store for the 
first time, you’ll be asked whether you want to see iTunes Plus or old 
iTunes content while you browse the store. If you select Cancel, you’ll be 
presented with 99-cent-per-song pricing and standard iTunes albums.
iTunes will let you know when an iTunes Plus album or video is available 
as an alternative to whatever you’re looking at. But if you select iTunes 
Plus, the 99-cent song pricing will be replaced by a new price whenever 
iTunes Plus content is available: a plus icon appears, along with a $1.29 
per track (US) Buy Song option. Albums and videos will be tagged as 
iTunes Plus, and download in that format automatically.



219

The Free iPod Book 3.3 iTunes Tips & Tricks 
Managing Your iTunes Plus Account Settings

Visiting the iTunes Plus section of the iTunes Store 
results in a question: do you care about higher-quality 
music enough to buy it by default, or do you want 
the less expensive, lower-quality stuff to be shown 
instead? At first, you may think you know the best 
answer for your own personal preferences, but you may 
change your mind in the future. That’s where the iTunes 
Plus Preference comes in.

Under the Search iTunes Store box at the top right of 
your iTunes window, there’s a Sign In or e-mail address 
box you can click for your Account Information. After 
clicking on this box, and selecting View Account, 
you’ll see that the top box lists iTunes Plus as enabled 
or disabled. Clicking on Manage iTunes Plus lets you 
change your preference from one to the other.

If selected, the “Always Show Me” box doesn’t obligate 
you to make higher-priced purchases - it just simplifies 
the look of the iTunes Store so that you don’t have to see 
low-quality songs, albums, and videos when better ones 
are available. You can always change back later.

Upgrade (Some) Music to iTunes Plus

If you bought pre-iTunes Plus music from the iTunes Store, 
and wish you’d held out for better tracks, you’re in luck: the 
iTunes Plus section of the Store now offers “Upgrade My 
Library.” This automatically figures out which previously 
purchased songs, music videos, and albums are eligible 
for upgrade, and gives you a total price. U.S. prices are 30 
cents per song, 30% of the total album price, or 60 cents per 
music video; foreign currencies have different (and generally 
higher) prices. Note: you can’t upgrade songs unless a label 
supports iTunes Plus, so plan to wait a while for many songs.
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Using iTunes to activate an iPhone

When Apple released iTunes 7.3, it didn’t mince words: 
this was the update designed specifically to bring iPhones 
into American homes. Though many of the software’s new 
features are hidden away from plain view, connecting an 
iPhone leads to a collection of new screens and options, 
starting with an AT&T activation and registration process. 

iTunes has made this almost as easy as possible, though 
Apple is unusually strict about forcing you to go through 
the process, and perhaps repeat certain steps if you need 
to restore iPhone’s system software. Activation simply 
requires you to pick an AT&T service plan, provide billing 
and credit card information, and wait for a new or old 
phone number to be assigned or transferred. Currently, 
you need to agree to a two-year service contract with 
AT&T, pay a $36 activation fee, and accept either a $60 (and 
up) combined voice and data plan, or a $20 per month 
data plan, in order to activate the phone. Under some 
circumstances, you’ll need to actually visit an AT&T retail 
store - specifically one listed on the company’s web site as 
a vendor of iPhones, and not one of the many franchise 
stores out there - in order to have an in-person credit 
check performed. And under other circumstances, such as 
failing the credit check, AT&T will decide that you’ll only be 
approved for a monthly pay-as-you-go account, which costs 
more per month but doesn’t require a two-year contract.

Only after activation has been completed will the iPhone’s 
full feature set - phone, web, mail, and iPod - be unlocked. 
At that point, you’ll be able to transfer audio and video to 
the iPhone, as well as newly critical contacts and bookmarks 
from your Mac or PC. The process isn’t exactly iPod-like, as 
you’ll see below. 

Why iPhone’s no iPod: no Disk Mode, 
no Drag & Drop

Once your iPhone has been activated and is 
starting the synchronization process with iTunes, 
you’ll discover that it doesn’t work in the way 
you’d expect: yes, it appears under your Devices 
list, but it operates like an Apple TV, not an iPod.

What that means is that there’s no Disk Mode to 
allow iPhone to store your data, and rather than 
just dragging and dropping any music or video 
file you’d like to store in its flash memory, you 
need to add music files from playlists, and videos 
or podcasts by checking boxes found under the 
Video and Podcasts tabs. All of the details are on 
the next page; suffice to say that we really hope 
that Apple changes these limits in an update.
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Adding Music, Movies, and Photos to iPhone

Unlike the iPod, all iPhone synchronization - not just photos, 
contacts, and calendars - is handled through tabs accessed after 
you select iPhone from the Devices list. Once you’ve found the 
separate tabs for Music, Photos, Podcasts, and Video next to the 
Summary and Info Tabs, you’ll need to take the next step: adding 
checkmarks to content before it will sync to iPhone. Movies are 
checked on an individual basis; TV shows are picked by two criteria: 
first, the name of the show, and second, how many episodes of the 
show you want to sync. Podcasts follow the same formula as TV 
shows.

Music is different. If you haven’t been using playlists with your 
iPod, you’ll need to set up at least one for the iPhone, specifying 
which songs you want to transfer. You can monitor the total size (in 
Gigabytes) of the playlist at the bottom of the iTunes window, then 
check it under the Music Tab to send all the songs to your iPhone.

Synchronizing Contacts, Calendars, 
Bookmarks & Mail to iPhone: the Info Tab

Rather than forcing you to wade through multiple tabs 
to transfer over your computer’s contacts, calendars, 
bookmarks and e-mail accounts to the iPhone, iTunes 
combines all of these synchronization options in a 
single iPhone Tab: “Info.” It’s the first tab you’ll find after 
the Summary Tab, which appears by default when you 
select the iPhone from your Devices list, showing you 
your iPhone’s telephone number, software version, serial 
number and storage capacity.

Selecting “Info” on a Mac lets you choose to synchronize 
contacts from Apple’s or Yahoo!’s Address Book programs; 
on a PC, you can pick from Windows Address Book, 
Outlook Express, or Outlook (2003 or later). If you’re using 
another program, such as AOL, to manage your contacts, 
you can import them into one of these formats using 
a program such as AOL’s Service Assistant (apple.com/
downloads/macosx/internet_utilities/aolserviceassistant.
html), a process that’s relatively quick and painless. Mail 
accounts similarly are synchronized from either Outlook 
Express or Outlook (2003 or later) on a PC, or OS X Mail 
on a Mac; iTunes only transfers your account information, 
and not the e-mail itself, to the iPhone.

Calendars are synchronized from iCal on a Mac, or 
Outlook (2003 or later) on a PC; iPhone is able to display 
both the marked dates on your computer’s calendar, and 
details about the events. You can sync web bookmarks 
from Safari on a Mac or PC, as well as Internet Explorer 
on the PC; doing this enables you to browse all of your 
favorite web sites with a single button tap rather than 
having to enter addresses in manually.
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Keep your iPhone’s Software and 
content fresh

The iPhone’s Summary Tab is only rarely useful: as 
shown in the photo, it tells you the name of your 
iPhone, its capacity, software version, serial number 
and phone number. There’s a pretty good chance that 
you know at least three of those details already; the 
software version and serial number are the only parts 
you will likely need to reference.

Apple has promised that it will regularly update the 
iPhone with new software to help expand its features 
and fix bugs; it appears likely that these updates will 
continue for a given model for roughly two years. The 
Summary Tab helps you figure out which version 
of the software you’re running - here, it’s version 
1.0.1 - and provides a button that lets you check 
automatically for software updates. A check box 
lets you update the iPhone’s content every time you 
connect it to your computer, too. No other cell phone 
makes syncing and upgrades this easy. 

You can also use the Restore button if your iPhone 
has developed what you suspect to be a software 
problem; it wipes your phone completely clean, and 
replaces the software with a fresh copy. You’ll need 
to go through verification of your prior activation - a 
quick process, assuming you properly activated the 
phone - and then you’ll be have to re-synchronize your  
audio, video, and “Info.” 

Back up your iPhone: the Preferences Tab

Most of the Preferences you’ll find in iTunes (Control 
key and the Comma key on the PC, or Command key 
and Comma key on a Mac) are packed with options. 
Not so with the iPhone: at least as of iTunes 7.3, the 
only two options are “Remove Backup” and “Disable 
automatic syncing for all iPhones.”

By default, iTunes backs up your iPhone’s settings 
every time you synchronize, and provides a time 
and date of the last backup. You don’t need to do 
anything to initiate the backup, and you also can’t turn 
backups off. But you can delete the backup if you want 
to save space, using the obviously named Remove 
Backup button. Keeping the backup will help if you 
need to wipe iPhone clean or replace it with a new 
iPhone. Disabling automatic synchronization here is 
little more than an across-the-board alternative to the 
“Automatically sync when this iPhone is connected” 
option under the Device Summary Tab. Check this, 
and you’ll uncheck the Summary box for all iPhones.
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Use iPhone as a Contact & Bookmark conduit

Once you’ve used the Info Tab to synchronize one computer’s contacts, 
calendar information, and bookmarks to your iPhone, you’ll discover two 
things: first, the iPhone is suddenly loaded with excellent shortcuts to 
speed up your phone calls, web site visits, and event scheduling. Second, 
and unlike an iPod, you can actually edit the content using the iPhone, and 
transfer it back to a PC or Mac.

Note that we used the word “a” rather than “the.” You’re not limited to 
synchronizing this content - iTunes calls it all “Info” - to the original computer it 
came from. Instead, you can take one PC or Mac’s Info, and transfer it to another 
machine, regardless of whether the first or second computer is a PC or a Mac. In 
other words, you can use iPhone to transfer contacts, bookmarks, and calendar 
information from your Mac at home to your office PC, or from one PC or Mac 
to another: just use the Merge Info button that appears after connecting the 
iPhone. A window will let you know how much of a change you’re about to 
make to your computer’s existing content, and inform you of each specific 
conflict between the iPhone’s contacts and the computer’s, so you can choose 
which contact to keep. You can also wipe iPhone’s initially synchronized Info 
and replace it with the second computer’s Info using the Replace Info button.

Unfortunately, the Merge Info button doesn’t work with music, video, or 
podcasts. For now - probably forever - double-syncing is for Info only, so 
you’ll see an Erase and Sync dialog for this sort of content, instead. We expect 
that Apple will update these windows to make the difference between “Info 
Syncing” and “Library Syncing” more obvious for users.

Help Apple trace iPhone bugs

Congratulations! You just purchased a first-generation 
iPhone, a cutting-edge piece of technology that’s 
unlike any other product Apple has previously 
released. Though you might not have realized it, that 
means that you’ve just become a beta tester for the 
iPhone family - assuming you’re willing to help.

Perhaps not surprisingly, the iPhone’s initial version 
1.0 and 1.0.1 software releases are buggy. Safari 
crashes a lot, Mail doesn’t properly download 
messages all the time, and other applications have issues, too. To its credit, 
iPhone quietly takes notes when it’s struggling, and stores them to help 
Apple figure out what went wrong, and why. Afterwards, when you re-sync 
your iPhone, this dialog box will come up to ask if you mind sharing the 
information. Go ahead, it’s safe. If you have some reason to keep it quiet, 
“Don’t Send,” and make sure “Do not ask me again” is checked. iTunes won’t 
bother you any more.
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Adapter/Cable Manufacturers
 
Addlogix
http://www.addlogix.com
800-344-6921
sales@addlogix.com

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

Bluelounge
http://www.bluelounge.com/
(626) 564-2802
mail@bluelounge.com

BoxWave
http://www.boxwave.com/
customerservice@boxwave.com

BrightonNet Co.
http://www.brightonnet.co.jp/
81-3-5812-5735
export@brightonnet.co.jp

The iPod Directory. Whether you’re looking for the contact information
for an iPod accessory maker or companies that offer iPod-related services, 
start with our Directory - all the key players are listed here, and easy to find.

Dr. Bott
http://www.drbott.com
877-611-2688
support@drbott.com

ezGear (Audio Outfitters)
http://www.ezgear4u.com
(800) 780-IPOD, 801 563-1600
info@ezGear4u.com

FriendTech

(886)-2-87738986
sales1@friendtech.com

Gadget Accessories, LLC, Inc.
http://www.gadgetaccessories.com/
(888) 368-5238
sales@gadgetaccessories.com

Global Source
http://www.glblsrc.com/
info@glblsrc.com

Griffin Technology
http://www.griffintechnology.com/
(615) 399-7000
support@griffintechnology.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

Intuitive Devices, Inc.
http://www.blinkitnow.com/
mail@intuitivedevices.com

Kensington
http://www.kensington.com/
(650) 572-2700

Logic3/SpectraVideo
http://www.logic3.com
support@logic3.com

Logiix
http://www.logiix.net/
http://www.logiix.net/contact.htm

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

Monster Cable Products, Inc.
http://www.monstercable.com/
(415) 840-2000

Newer Technology
http://www.newertech.com/
(800) 275-4576
sales@newertech.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

Pacific Rim Technologies
http://www.pacrimtechnologies.com/
(949) 481-2443
info@pacrimtechnologies.com

PodGear
http://www.podgear.net/
+44 (0) 1494 522 721
info@disruptivegroup.com

SendStation
http://www.sendstation.com/
+49 (69)-94413841
info@sendstation.com

SiK
http://www.sik.com/
(650) 701-1745
info@sik.com

Sima Products
http://www.simaproducts.com/
800-345-7462
http://www.simaproducts.com/
contact_us.php

Sonnet Tech
http://www.podfreq.com/
(949) 472-2772
support@sonnettech.com
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The iPod Directory is the first comprehensive listing of major providers of iPod-related goods and services, located 
around the world. We have attempted to include as many companies as possible in the Directory, and do not require 
advertising or other editorial participation in order to add a qualified business name to this list. If you are the owner 
of a business and wish to submit or update information on your business, please visit ilounge.com/directory/.
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SwitchEasy, Ltd.
http://www.switcheasy.com/

Tunewear
http://www.tunewear.com/
info@tunewear.com

Upbeat Audio
http://www.upbeataudio.com
616-837-9500
services@upbeataudio.com

Xitel Pty, Ltd.
http://www.xitel.com/
(512) 331 5799
nasales@xitel.com

XtremeMac
http://www.xtrememac.com/
866-392-9800
support@xtrememac.com

Battery Manufacturers

Battery Technology, Inc. (BTI)
http://www.batterytech.com/
(626) 336-6878
info@batterytech.com

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

Better Energy Systems
http://www.solio.com/
solio@betterenergy.co.uk

Bosity
http://www.bosity.com/
(905) 415-0800
customer_service@websecuremail.com

BrightonNet Co.
http://www.brightonnet.co.jp/
81-3-5812-5735
export@brightonnet.co.jp

Compact Power Systems, LLC
www.cpsyst.com
800-833-1070
customerservice@cpsyst.com

ezGear (Audio Outfitters)
http://www.ezgear4u.com
(800) 780-IPOD, 801 563-1600
info@ezGear4u.com

FastMac
http://www.fastmac.com/
(408) 850-6232
support@fastmac.com

Gadget Accessories, LLC, Inc.
http://www.gadgetaccessories.com/
(888) 368-5238
sales@gadgetaccessories.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

iPodResQ
http://www.ipodresq.com/
(877) POD-REPA
info@ipodresq.com

Maxell
http://www.maxell-usa.com/
(800) 533-2836
techsupp@maxell.com

Newer Technology
http://www.newertech.com/
(800) 275-4576
sales@newertech.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

PDASmart
http://www.pdasmart.com/
(512) 258-4500
info@PDASmart.com

TechRestore, Inc.
http://techrestore.com/
(866) 967-3786
help@techrestore.com

Tekkeon
http://www.tekkeon.com/
(888) 787-5888
Support@Tekkeon.com

Battery Replacement Services

Apple Inc.
http://www.apple.com/
(408) 996-1010

Compact Power Systems, LLC
www.cpsyst.com
800-833-1070
customerservice@cpsyst.com

FastMac
http://www.fastmac.com/
(408) 850-6232
support@fastmac.com

iResQ
http://www.iresq.com/
(877) POD-REPA
info@iresq.com

Other World Computing
http://eshop.macsales.com/
(800) 275-4576

RapidRepair
http://www.rapidrepair.com/
(888) 763-6637
sales@rapidrepair.com

TechRestore, Inc.
http://techrestore.com/
(866) 967-3786
help@techrestore.com

UKiPodRepairs
http://www.ukipodrepairs.co.uk/
info@ukipodrepairs.co.uk

Car Accessory Manufacturers

Alpine Electronics of America, Inc
http://www.alpine-usa.com/
310.326.8000

Audiovox
http://www.audiovox.com/
1-631-231-7750
Web Based Contact

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

Blitzsafe of America, Inc.
http://www.blitzsafe.com/
(201) 569-5000
blitzsafe@blitzsafe.com

BMW of North America, LLC
http://www.bmwusa.com/
(800) 831-1117

Clarion Corp. of America
http://www.clarion.com/usa/
800-GO-CLARION (462-5274)

iLounge reserves the right to exclude any business from this listing at any time if, in iLounge’s sole judgment, such 
business has engaged in practices in violation of our Policy on Harmful Accessories, or other deceptive practices. 
However, omission from this list may be inadvertent or for other reasons, and should not be construed as a judgment 
that any omitted company is engaged in such practices. An updated iPod Directory will be available on iLounge.com.
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Connects2
http://www.connects2.com/
+44 1384 291122
sales@connects2.com

Daihatsu Motor Co., Ltd.
http://www.daihatsu.com/
800-777-7070

Dension USA
http://www.densionusa.com
1-866-822-3673
info@densionusa.com

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

Dr. Bott
http://www.drbott.com
877-611-2688
support@drbott.com

FriendTech
(886)-2-87738986
sales1@friendtech.com

GBX Direct
http://www.gbxdirect.com/
(800) 571-2551

Global Source
http://www.glblsrc.com/
info@glblsrc.com

Griffin Technology
http://www.griffintechnology.com/
(615) 399-7000
support@griffintechnology.com

Hebe Styling
http://www.hebestyling.com/
+44 (0)1132 892 637
info@hebestyling.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

Kensington
http://www.kensington.com/
(650) 572-2700

Kenwood
http://www.kenwoodusa.com
310-639-9000
http://kenweb1.kenwoodusa.
com/KenwoodPortal/
KenwoodAudio/email/feedback.
aspx?subject=generalquestions

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

Monster Cable Products, Inc.
http://www.monstercable.com/
(415) 840-2000

Neo Car Audio
http://www.neocaraudio.com/
(619) 819-0758
sales@neocaraudio.com

Newer Technology
http://www.newertech.com/
(800) 275-4576
sales@newertech.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

Pacific Accessory Corp.
http://www.pac-audio.com/
(714)835-3022

Pacific Rim Technologies
http://www.pacrimtechnologies.com/
(949) 481-2443
info@pacrimtechnologies.com

Peripheral Electronics
http://peripheralelectronics.com/
(727) 572-9255
Support@peripheralelectronics.com

Pioneer Electronics
http://www.pioneerelectronics.com
http://www.pioneerelectronics.com/
pna/contact/us/0,,2076_4351,00.
html?fpSiteId=2076

Pioneer Electronics Inc
http://www.pioneerelectronics.com
Web Based Contact

PodGear
http://www.podgear.net/
+44 (0) 1494 522 721
info@disruptivegroup.com

Precision Interface Electronics (P.I.E.)
http://www.pie.net/
(800) 526-8590
info@pie.net

Pro-Fit International, Inc.
http://www.pro-fit-intl.com/
(800) 388-0073
sales@pro-fit-intl.com

Proclip
http://www.proclipusa.com/
(800) 296-3212
support@proclipusa.com

Scosche Industries
http://www.scosche.com/
(800) 363-4490
sales@scosche.com

Scosche Industries
http://www.scosche.com
800-363-4490
techsupport@scosche.com

SiK
http://www.sik.com/
(650) 701-1745
info@sik.com

Sima Products
http://www.simaproducts.com/
800-345-7462
http://www.simaproducts.com/
contact_us.php

Sonnet Tech
http://www.podfreq.com/
(949) 472-2772
support@sonnettech.com

Tekkeon
http://www.tekkeon.com/
(888) 787-5888
Support@Tekkeon.com

TEN Technology
http://www.tentechnology.com/
(800) 518-4TEN
info@tentechnology.com

XtremeMac
http://www.xtrememac.com/
866-392-9800
support@xtrememac.com

Case & Clip Manufacturers

A-1 Quality Products (A1QP)
http://www.a1qp.com
866-476-3763
http://www.a1qp.com/shop/contact_
us.php

A.B. Sutton
http://www.absutton.com/
help@absutton.com

Abitax Inc.
http://www.abitax.co.jp/
03-3407-2817 (81-3-3407-2817)
info@abitax.co.jp

Acme Made
http://www.acmemade.com/
(888) 486-3191
info@acmemade.com

Agent18
http://www.agent18.com/
questions@agent18.com

Allsop
http://www.allsop.com
800-426-4303
http://www.allsop.com/
customerservice.asp
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Aneta Genova, Inc.
http://www.anetagenova.com/
(212) 965-1089
info@anetagenova.com

Anya Hindmarch
http://www.anyahindmarch.com

Apple Inc.
http://www.apple.com/
(408) 996-1010

Arty
http://wrappers.typepad.com/arty/
debbieabroad@aol.com

AVA Showcase
http://www.ava.com.sg/
852 8120 3131
sales@avashowcase.com

Axio LLC (Harodesign)
http://www.axio-usa.com
760-557-0123

be.ez Bags
http://www.be-ez.com
sales@be-ez.com

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

Bird Electron
http://www.bird-electron.co.jp

Body Glove International
http://www.bodyglove.com/
(310) 374-3441
info@bodyglove.com

Boomwave Products
http://www.thepodstar.com/
info@thepodstar.com

Booq, LLC.
http://www.booqbags.com/
(626) 836-9365

BoxWave
http://www.boxwave.com/
customerservice@boxwave.com

Brando Workshop
http://shop.brando.com.hk/
brando@brando.com.hk

BrightonNet Co.
http://www.brightonnet.co.jp/
81-3-5812-5735
export@brightonnet.co.jp

Bruddy, LLC.
http://www.bruddy.com/
info@bruddy.com

Buddiez, Inc.
http://www.podbuddies.com/
admin@ibuddiez.com

Budfrog (Hook Industries, LLC.)
http://budfrog.com/
info@budfrog.com

Burberry
http://www.burberry.com/
(866) 589-0499

Burning Love
http://www.burninglove.biz/

Burton Snowboards
http://www.burton.com/
(800) 881-3138
info@burton.com

C. Ronson
http://cronsonnyc.com/
(212) 497-2121
jennifer@cronsonnyc.com

C6 Manufacturing
http://www.c6mfg.com/
support@c6mfg.com

Capdase
http://www.capdase.com/
(852) 2191 2173
info@capdase.com

Carrie Scott/Herchmer
http://www.carriescott.com
310-315-1716
sales@carriescott.com

Case Closed Bags, Inc.
http://www.caseclosedbags.com/
(866) 366-0913
april@caseclosedbags.com

Case-Mate
http://www.case-mate.net/
(866) 689-3432

Casemandu (Hook Industries, LLC.)
http://casemandu.com/
info@casemandu.com

Catherine’s Pita Shop
http://www.catherinespita.com/
cat@catherinespita.com

Chanel
http://www.chanel.com/
(800) 550-0005

Chums, Inc.
http://www.chums.com/
(800) 222-CHUM

COACH
http://www.coach.com/
1-800-444-3611

Colette meets Comme des Garçons
http://www.
colettemeetscommedesgarcons.com/
+81 (0) 3 5468 8301
contact@ 
colettemeetscommedesgarcons.com

Contour Design, Inc.
http://contourcase.com/
(800) 462-6678
info@contourdesign.com

Core Cases
http://www.corecases.com
866-228-7896
customerservice@corecases.com

Covertec
http://www.covertec.com
http://www.covertecstore.com/clients/
identification.asp?from=contact

Crumpler Bags
www.crumplerbags.com
718-384-3020
mail@crumplerbags.com

Das Blau, LLC.
http://www.dasblau.com/
(212) 254-3724
sales@dasblau.com

DecalGirl
http://www.decalgirl.com/
(866) 841-0922
support@decalgirl.com

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

Dior Homme
http://fashion.dior.com/homme/

Diral
http://d-tokyo.com/
03-3464-4747
info@d-tokyo.com

Dunhill (Alfred Dunhill)
http://www.dunhill.com
212-753-9292
customer.services@dunhill.com

DVForge/MacMice
http://www.macmice.com/
(615) 822-9270
jack@dvforge.com

E&B Company
http://www.ebcases.com/
(858) 385-1976
cs@ebcases.com

Earthly Treasures
http://www.earthlytreasures.co.uk/
0845 838 0765



228

ipod directory The Free iPod Book 3.3

Eroch Studios
http://www.lilipods.com/
info@lilipods.com

everQuest Design, Inc.
http://www.everquestdesign.com/
(514) 229-4321
customerservice@everquestdesign.com

eXopod
http://www.exopod.net/
(708) 341-7218
exopod@gmail.com

Extreme Limit
http://www.extreme-limit.co.jp/english/
81-3-3847-2994
info@extreme-limit.co.jp

ezGear (Audio Outfitters)
http://www.ezgear4u.com
(800) 780-IPOD, 801 563-1600
info@ezGear4u.com

FeltCafe
http://www.feltcafe.net/
liz@feltcafe.net

Foofpod
http://foofpod.com/
foof@foofshop.com

Fossil, Inc.
http://www.fossil.com/
(972) 234-2525
webguy@fossil.com

Gadget Accessories, LLC, Inc.
http://www.gadgetaccessories.com/
(888) 368-5238
sales@gadgetaccessories.com

Gecko Gear Australia
http://www.geckogear.com.au

Geek Culture
http://www.geekculture.com/
orders@geekculture.com

GizMac
http://www.gizmac.com
(800) 475-1677
Sales@GizMac.com

Global Source
http://www.glblsrc.com/
info@glblsrc.com

Gravis
http://www.gravisfootwear.com
800-223-7450
info@gravisfootwear.com

Griffin Technology
http://www.griffintechnology.com/
(615) 399-7000
support@griffintechnology.com

Gucci
http://www.gucci.com/

H2O Audio
http://www.h2oaudio.com/
(858) 623-0339 x213
support@h2oaudio.com

handmade.kerstinberg.com
http://handmade.kerstinberg.com
handmade@kerstinberg.com

Handstands (American Covers Inc.)
http://www.handstands.com
888-228-8987
info@handstands.com

HeadRoom
http://www.headphone.com/
(800) 828-8184
support@headphone.com

HipTunes (Genre Collection, LLC.)
http://www.genrecollection.com/
(866) 436-7363
mail@genrecollection.com

Hotromz
http://www.hotromz.com/
support@hotromz.com

i2 Electronics
http://www.i2electronics.com/
1-888-8iLOCKr
customerservice@i2electronics.com

ifrogz/Reminderband
http://www.ifrogz.com
877-443-7649
http://ifrogz.com/contact.php

iJacket/Aquarius Industrial
http://www.ijacket.net
(852)2793-2310

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

iMojo
http://www.imojo.com/
service@imojo.com

Incase Designs Corporation
http://www.goincase.com/
(626) 338-6400 x 13
info@goincase.com

Innopocket
http://www.innopocket.com/
(852) 2406-0638
info@innopocket.com

iPoDonut
http://www.ipodonut.com/
esupport@iPoDonut.com

iPodstreet (Moftware/Fommy.com)
http://www.ipodstreet.com
866-820-4554
care@ipodstreet.com

iRock
http://www.myirock.com/
(847) 202-1900
info@fidinc.com

iSkin
http://www.iskin.com/
(416) 924-9607
inquire@iskin.com

iStyles (formerly iPodStyles)
http://www.istyles.com
sales@iStyles.com

itzKitz (iPodKitz)
http://www.ipodkitz.com/
+852 23407584
support@itzkitz.com

J.Crew
http://www.jcrew.com/
(800) 562-0258
contactus@jcrew.com

JAVOEdge Intl, LLC.
http://www.javoedge.com/
info@javoedge.com

JR Hill & Co.
http://www.jrhillandcompany.com/
(800) 258-3654
contact@jrhillandcompany.com

Kate Spade
http://www.katespade.com/home/
index.jsp
866-999-KATE

Kensington
http://www.kensington.com/
(650) 572-2700

Kiwali, LLC.
http://www.kiwali.com/
(510) 251-8001
info@kiwali.com

Koyono
http://www.koyono.com
216-373-2569
support@koyono.com

Kroo Cases (Leader Wireless)
http://www.leaderwireless.com
(626) 214-9228
sales@leaderwireless.com

Krusell
http://www.krusell.se
+46-31-338 00 00
info@krusell.se
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LifePod
http://www.lifepod.net/
(888) LIFEPOD
salespod@lifepod.net

Logiix
http://www.logiix.net/
http://www.logiix.net/contact.htm

Louis Vuitton
http://www.vuitton.com/
866.V.U.I.T.T.O.N
Web Based Contact

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

MacSkinz
http://www.macskinz.com/

Marware, Inc.
http://www.marware.com/
(954) 927-6031
info@marware.com

Matias Corporation
http://matias.ca/
(905) 265-8844
info@matias.ca

Maxell
http://www.maxell-usa.com/
(800) 533-2836
techsupp@maxell.com

MCA (Manhattan Cellular)
http://www.manhattan-cellular.com
http://www.manhattan-cellular.com/
srt/mca_en/contact/contact?location.
id:=2595

Miniot
http://www.miniot.com/
iwood@miniot.com

Mobile Juice (ShuffleArt)
http://www.shuffle-art.com/

Monster Cable Products, Inc.
http://www.monstercable.com/
(415) 840-2000

Mophie Inc.
http://www.mophie.com
888-8-Mophie
team@mophie.com

Moshi (Aevoe)
http://www.aevoe.com/moshi/

MuffGear
http://muffgear.com/
sales@muffgear.com

Nike, Inc.
http://www.nike.com/
(800) 344-6453

NikkiPod
http://www.nikkipod.com/

Noreve
http://www.noreve.com/
info@noreve.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

O’Neill, Inc.
http://www.oneill.com/

Ocean Trust Companies
http://ipockets.net/
(954) 427-6125
mosborn@oceantrustcompanies.com

OP/TECH USA
http://www.optechusa.com/
(888) OPTECH-4
info@optechusa.com

Otter Products, LLC.
http://www.otterbox.com/
(888) 695-8820
customerservice@otterbox.com

Paag
http://www.paagpak.com/
customersupport@paagpak.com

Pacific Design Ltd.
http://www.pacificdesign.com/
888-797-8755
info@pacificdesign.com

Pacific Rim Technologies
http://www.pacrimtechnologies.com/
(949) 481-2443
info@pacrimtechnologies.com

Paul Frank Industries USA
http://www.paulfrank.com
(949) 515-7950

Paul Smith
http://www.paulsmith.co.uk
(44) 207 836 7828
info@paulsmith.co.uk

PDair Workshop
http://www.pdair.com/
enquiry@pdair.com

Pelican Products, Inc.
http://www.pelican.com/
(800) 473-5422
sales@pelican.com

Piel Frama
http://www.pielframa.com/
+34 956 46 12 55
info@pielframa.com

Pixelgirlshop
http://www.pixelgirlshop.com/
(734) 929-9603
pixelgirl@pixelgirlshop.com

PodBrix
http://podbrix.com/
info@PodBrix.com

PodGear
http://www.podgear.net/
+44 (0) 1494 522 721
info@disruptivegroup.com

PodShirt
http://podshirt.com/
info@PodBrix.com

Portable Device Outfitters (PDO)
http://www.PDOstore.com/
sales@PDOstore.com

Power Support (USA), Inc.
http://www.powersupportusa.com/
(818) 558-1645
CustomerService@PowerSupportUSA.
com

Prada
http://www.prada.com/

Proporta
http://www.proporta.com/
(888) 331-0803
sales@proporta.com

Pyrim Technologies
http://www.pyrim.com/
(469) 366-4440
support@pyrim.com

RadTech, LLC.
http://www.radtech.us/
(314) 209-9993
info@radtech.us

Rhinoskin
http://www.saunders-usa.com/
(800) 341-4674
csr@saunders-usa.com

Rivet International
http://www.rivetnow.com/
(858) 793-4433
customerservice@rivetnow.com

SBS Innovations Inc.
www.ishok.com
contact@shokproof.com

Scosche Industries
http://www.scosche.com/
(800) 363-4490
sales@scosche.com

Sena Cases
http://www.senacases.com/
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ShieldZone Corporation
http://www.shieldzone.com/
(801) 263-0699
questions@shieldzone.com

Shufflesome iPod Stickers
http://www.shufflesome.com

SKProducts, LLC
http://www.thecarclip.com
(207)680-4009
sales@thecarclip.com

Speck Products
http://www.speckproducts.com/
(650) 463-8914
info@speckproducts.com

Standard Technical Merchandise (STM)
http://www.stmbags.com.au
info@stmbags.com.au

Sumajin
http://www.sumajin.com/

Sumo Cases
http://www.sumocases.com/
info@sumocases.com

SwitchEasy, Ltd.
http://www.switcheasy.com/

Target
http://www.target.com/
(612) 304-6073
Guest.Relations@target.com

Targus Group International, Inc.
http://www.targus.com/
(877) 482-7487

Tatuz International, LLC.
http://www.shuffletatu.com/
(314) 724-2224
info@tatuz.com

Terforma
http://www.terforma.com/
(866) TER-FORM
info@terforma.com

Teski
http://www.teski.com/
(972) 333-0964
sam@teski.com

Timbuk2
http://www.timbuk2.com/
customerservice@timbuk2.com

Toteplus, Inc.
http://www.toteplus.com/
(650) 331- 0161
info@toteplus.com

TuneBuckle
http://www.tunebuckle.com
404-961-7206
fraser@tunebuckle.com

Tunewear
http://www.tunewear.com/
info@tunewear.com

Vaja Cases
http://www.vajacases.com/
info@vajacases.com

Vakaadoo
http://www.vakaadoo.com/
+44 845 895 1002
info@vakaadoo.com

Waterfield Designs
http://www.sfbags.com/
(877) 546-1040
askgary@sfbags.com

Winzz, Inc.
http://www.theiface.com/
+886-2-8751-0601
info@theiface.com

XtremeMac
http://www.xtrememac.com/
866-392-9800
support@xtrememac.com

Yoshida Kaban
www.yoshidakaban.com
03 - 3862 - 1021

Zofunk Products
http://www.zofunk.com
service@zofunk.com

CD Ripping Services

Awaken Solutions, LLC.
http://www.awaken.com/
(877) 385-2076
info@awaken.com

dmp3 Music
http://www.dmp3music.com
(888) 599-3673
info@dmp3music.com

Get Digital, Inc.
http://www.getdigitalinc.com/
(800) 714-4744
info@getdigitalinc.com

Moondog Digital, Inc.
http://www.moondogdigital.com/
(888) CDS-2-MP3
info@moondogdigital.com

MusicRip, Ltd.
http://www.musicrip.com/
orders@musicrip.com

PacificRip
http://www.pacificrip.com/
(888) RIP-DISC
info@pacificrip.com

Pickled Productions Inc.
http://www.pickledproductions.com
(866) 937-4748
info@pickledproductions.com

ReadyToPlay
http://www.readytoplay.com/
(650) 213-9300
sales@readytoplay.com

RipDigital
http://www.ripdigital.com/
(877) 759-3914

RipIt Digital LLC
www.RipItDigital.com
773-600-4733
info@RipItDigital.com

RipShark, LLC.
http://www.ripshark.com/
(800) 379-3515
contact@ripshark.com

RipTopia
http://www.riptopia.com/
(800) 874-4921

Cleaner / Polish Manufacturers

Applesauce Polish
http://www.applesaucepolish.com
info@applesaucepolish.com

Brando Workshop
http://shop.brando.com.hk/
brando@brando.com.hk

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

iCleaner
http://www.ipodcleaner.com/
info@ipodcleaner.com

PodShop, LLC
http://podshop.com/
info@podshop.com

RadTech, LLC.
http://www.radtech.us/
(314) 209-9993
info@radtech.us

Customizing Services

Colorenvy
http://www.colorenvy.com/
(616) 389-3403
casey@colorenvy.com
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ColorWare, Inc.
http://www.colorwarepc.com/
(888) 452-6567
sales@color-ware.com

Devoted1
http://www.devoted1.com/

ETCHamac, LLC.
http://www.etchamac.com/
(480) 964-6352
sales@etchamac.com

Intuitive Devices, Inc.
http://www.blinkitnow.com/
mail@intuitivedevices.com

iPodMods
http://www.ipodmods.com/
(888) 763-6637
sales@ipodmods.com

Simple Solutions Technology 
(CrystalMini)
http://www.crystalshuffle.com/
(718) 837-8883
mailto:info@crystalmini.com

FM Transmitter Manufacturers

Battery Technology, Inc. (BTI)
http://www.batterytech.com/
(626) 336-6878
info@batterytech.com

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

C. Crane
http://www.ccrane.com/
(800) 522-8863
ccraneco@aol.com

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

Dr. Bott
http://www.drbott.com
877-611-2688
support@drbott.com

Griffin Technology
http://www.griffintechnology.com/
(615) 399-7000
support@griffintechnology.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

Kensington
http://www.kensington.com/
(650) 572-2700

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

Maxell
http://www.maxell-usa.com/
(800) 533-2836
techsupp@maxell.com

Monster Cable Products, Inc.
http://www.monstercable.com/
(415) 840-2000

Scosche Industries
http://www.scosche.com
800-363-4490
techsupport@scosche.com

Sonnet Tech
http://www.podfreq.com/
(949) 472-2772
support@sonnettech.com

Tekkeon
http://www.tekkeon.com/
(888) 787-5888
Support@Tekkeon.com

XtremeMac
http://www.xtrememac.com/
866-392-9800
support@xtrememac.com

Head/Earphone Manufacturers

AKG Acoustics / Harman Kardon
http://www.akg.com
615-620-3800
akgusaservice@harman.com

Audio-Technica Foldable Compact 
Speakers
http://www.audio-technica.com
330-686-2600
sales@atus.com

Aural New York
http://www.auralnewyork.com
info@auralnewyork.com

BlueTake
http://www.bluetake.com/
(626) 369-9888
usa@bluetake.com

Design Annex (iBeat)
http://www.ibeatusa.com/
info@designannex.com

DVForge/MacMice
http://www.macmice.com/
(615) 822-9270
jack@dvforge.com

Etymotic
http://www.etymotic.com/
(847) 228-0006
customer-service@etymotic.com

FriendTech
(886)-2-87738986
sales1@friendtech.com

FutureSonics
http://www.futuresonics.com/
(877) FSI-EARS
info@futuresonics.com

GlobalSat Technology Corp.
http://www.usglobalsat.com
626-968-4145
akotoff@usglobalsat.com

Headbanger Audio
http://www.headbangeraudio.com/
(800) 331-3844
support@headbangeraudio.com

HeadRoom
http://www.headphone.com/
(800) 828-8184
support@headphone.com

Icuiti Corporation
http://www.icuiti.com/
(585) 240-8000
technical_support@icuiti.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

Logiix
http://www.logiix.net/
http://www.logiix.net/contact.htm

Logitech
http://www.logitech.com/
(510) 795-8500

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

Oakley
http://www.oakley.com
800-403-7449
info@oakley.com

Philips Electronics
http://www.philips.com
212-536-0500

Plane Quiet (Pro Travel Gear)
http://www.planequiet.com/
(800) 720-5076
customerservice@protravelgear.com

Plantronics, Inc.
http://www.plantronics.com/
(800) 544-4660

Semsons & Co. Inc.
http://www.semsons.com/
(626) 574-5557
info@semsons.com
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Sennheiser
http://www.sennheiserusa.com/
(860) 434-9190
info@sennheiserusa.com

Shure
http://www.shure.com/
(847) 600-2000
info@shure.com

Simpl Acoustics
http://www.simpl.com/
support@simpl.com

Sony Electronics
http://www.sony.com/
(800) 222-7669
http://esupport.sony.com/EN/feedback/
emailform-cons.html

TEN Technology
http://www.tentechnology.com/
(800) 518-4TEN
info@tentechnology.com

Ultimate Ears
http://www.ultimateears.com/
(800) 589-6531
customerservice@ultimateears.com

v-moda
http://www.v-moda.com
888-866-3252
acquire@v-moda.com

Westone Laboratories
http://www.westone.com
(719) 540-9333
westone@westone.com

Wi-Gear, Inc.
http://www.wi-gear.com/
(866) 434-4930

iPod/iTunes Hardware 
Manufacturers

Apple, Inc.
http://www.apple.com/
(408) 996-1010

Hewlett-Packard
http://www.hp.com/
(650) 857-1501

Motorola, Inc.
http://www.motorola.com/
(847) 576-5000

Remote Manufacturers

Advanced Bridging Technologies (ABT)
http://www.abtech2.com/
(888) 869-4737

Battery Technology, Inc. (BTI)
http://www.batterytech.com/
(626) 336-6878
info@batterytech.com

Engineered Audio, LLC.
http://www.engineeredaudio.com/
(636) 898-1053
support@engineeredaudio.com

Griffin Technology
http://www.griffintechnology.com/
(615) 399-7000
support@griffintechnology.com

Kensington
http://www.kensington.com/
(650) 572-2700

Keyspan
http://www.keyspan.com/
+1.510.222.0131
info@keyspan.com

Maxell
http://www.maxell-usa.com/
(800) 533-2836
techsupp@maxell.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

Onkyo Corporation
http://www.onkyo.com/
(201) 785-2600

Pacific Rim Technologies
http://www.pacrimtechnologies.com/
(949) 481-2443
info@pacrimtechnologies.com

Scosche Industries
http://www.scosche.com
800-363-4490
techsupport@scosche.com

Targus Group International, Inc.
http://www.targus.com/
(877) 482-7487

TEN Technology
http://www.tentechnology.com/
(800) 518-4TEN
info@tentechnology.com

Xitel Pty, Ltd.
http://www.xitel.com/
(512) 331 5799
nasales@xitel.com

Repair Services

Apple Inc.
http://www.apple.com/
(408) 996-1010

BrokeniPods
http://www.brokenipods.com/
(877) 293-0701
sales@brokenipods.com

DT&T Computer Services, Inc.
http://dttservice.com/ipod/
(800) 622-7977
customerservice@dttservice.com

iPod Correctors
http://www.ipodcorrectors.com/
josea@prtcnet.org

iPodMods
http://www.ipodmods.com/
(888) 763-6637
sales@ipodmods.com

iPodResQ
http://www.ipodresq.com/
(877) POD-REPA
info@ipodresq.com

iPodRestore
http://ipod.techrestore.com/
(877) FOR-IPOD
help@techrestore.com

Minilec Service, Inc.
http://www.minilec.com/
(800) 222-6075
info@minilec.com

PDASmart
http://www.pdasmart.com/
(512) 258-4500
info@PDASmart.com

TechRestore, Inc.
http://techrestore.com/
(866) 967-3786
help@techrestore.com

UKiPodRepairs
http://www.ukipodrepairs.co.uk/
info@ukipodrepairs.co.uk

Software Developers (iPod)

Electronic Arts / EA Mobile
http://www.eamobile.com/
http://support.jamdat.com/ics/support/
default.asp?deptID=1228

Elgato Systems, LLC
http://www.elgato.com/
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Enrique Quintero Design
http://enriquequinterodesign.com/
enrique@enriquequinterodesign.com

Helmes Innovations, LLC
http://www.helmesinnovations.com/
customerfeedback@helmesinnovations.com

iPodSoft
http://www.ipodsoft.com/

Neuros Technology International
http://www.neurosaudio.com/
866-563-8767
support@neurosaudio.com

PumpPod, LLC.
http://www.pumppod.com/
info@pumppod.com

TalkingPanda, LLC.
http://www.talkingpanda.com/
support@talkingpanda.com

Tanagra, Inc.
http://www.tanagra.com/
info@tanagra.com

ThinkFree
http://www.thinkfree.com/
(408) 432-5074
info@thinkfree.com

WuHan Venus Software, Inc.
http://ipod-application.com/
86-27- 88613551
support@ipod-application.com

Software Developers (Mac)

Avanquest Software
www.avanquest.com
720-330-1400

Bruno Blondeau
http://podmanager.brunoblondeau.
com/
contact@brunoblondeau.com

Crisp Softies
http://www.crispsofties.com/
cris@crispSofties.com

Elgato Systems, LLC
http://www.elgato.com/

Findley Designs, Inc.
http://www.findleydesigns.com/
FindleyDesigns@drewfindley.com

Helmes Innovations, LLC
http://www.helmesinnovations.com/
customerfeedback@helmesinnovations.com

iPodSoft
http://www.ipodsoft.com/

KennettNet Software Limited
http://www.kennettnet.co.uk/
support@kennettnet.co.uk

Lighthead Software
http://www.lightheadsw.com/
info@lightheadsw.com

Manfred Schwind
http://www.mani.de/index.html
mani@mani.de

Mibasoft
http://www.mibasoft.com/

Michael Zapp
http://www.cs.umanitoba.ca/~zapp/
MacOSX/
zapp@computer.org

Micromat
http://www.micromat.com/
(800) 829-6227
info@micromat.com

Odeo
http://www.odeo.com/
stuff@odeo.com

Pariahware, Inc.
http://www.pariahware.com/
info@pariahware.com

Podfitness.com
http://www.podfitness.com
888-4PODFIT
support@podfitness.com

PumpPod, LLC.
http://www.pumppod.com/
info@pumppod.com

Sci-Fi Hi-Fi
http://www.scifihifi.com/
podworks@scifihifi.com

Sonic Solutions (Roxio)
http://www.roxio.com/
(866) 280-ROXI

TalkingPanda, LLC.
http://www.talkingpanda.com/
support@talkingpanda.com

The Little App Factory
http://www.thelittleappfactory.com/

TiVo
http://www.tivo.com
877-289-8486

Wam Communications Group
http://www.dotpod.net/
+61 2 9869 8066
office@buyitonline.com.au

WuHan Venus Software, Inc.
http://ipod-application.com/
86-27- 88613551
support@ipod-application.com

youPod
http://www.kaisakura.com/youPod/

ZappTek
http://www.zapptek.com/
support@zapptek.com

Zelek Software
http://www.zeleksoftware.com/
support@zeleksoftware.com

Software Developers (PC)

Applian Technologies Inc.
http://www.replay-video.com/

Avanquest Software
www.avanquest.com
720-330-1400

Findley Designs, Inc.
http://www.findleydesigns.com/
FindleyDesigns@drewfindley.com

Helmes Innovations, LLC
http://www.helmesinnovations.com/
customerfeedback@helmesinnovations.
com

InterVideo
http://www.intervideo.com
510-651-0888
http://www.explorecommerce.com/
members/supportform.asp?Siteid=716

iPodSoft
http://www.ipodsoft.com/

iPodSync
http://www.ipod-sync.com/
support@ipod-sync.com

J. River, Inc.
http://www.jrmediacenter.com/

KennettNet Software Limited
http://www.kennettnet.co.uk/
support@kennettnet.co.uk

Mediafour Corporation
http://www.mediafour.com/
(515) 225-7409

Odeo
http://www.odeo.com/
stuff@odeo.com

Pariahware, Inc.
http://www.pariahware.com/
info@pariahware.com
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Podfitness.com
http://www.podfitness.com
888-4PODFIT
support@podfitness.com

PumpPod, LLC.
http://www.pumppod.com/
info@pumppod.com

Red Chair Software, Inc.
http://www.redchairsoftware.com/

TalkingPanda, LLC.
http://www.talkingpanda.com/
support@talkingpanda.com

Tanagra, Inc.
http://www.tanagra.com/
info@tanagra.com

ThinkFree
http://www.thinkfree.com/
(408) 432-5074
info@thinkfree.com

TiVo
http://www.tivo.com
877-289-8486

Wind Solutions
http://www.copypod.net/
copypod@copypod.net

WuHan Venus Software, Inc.
http://ipod-application.com/
86-27- 88613551
support@ipod-application.com

Zelek Software
http://www.zeleksoftware.com/
support@zeleksoftware.com

Speaker & Microphone 
Manufacturers

Altec Lansing Technologies, Inc.
http://www.alteclansing.com/
(866) 570-5702
csupport@alteclansing.com

Atech Flash Technology (AFT)
http://www.atechflash.com
510-824-6868
sales@atechflash.com

Athena Technologies / Audio Products 
International
http://www.athenaspeakers.com/
(716) 896-9801
http://www.athenaspeakers.com/
custservice.php

Audio Design Associates
http://www.ada-usa.com
800-HD-AUDIO

Bird Electron
http://www.bird-electron.co.jp

Bosch
http://www.bosch.com
224-232-2000

Bose
www.bose.com
1-800-999-2673 ext W99

Bosity
http://www.bosity.com/
(905) 415-0800
customer_service@websecuremail.com

Boynq
http://www.boynq.com
+31 71 4080 960
sales@boynq.com

Cambridge Soundworks
http://www.cambridgesoundworks.
com/
(800) FOR-HIFI

Creative Technology, Ltd.
http://www.creative.com/

Cyber Acoustics, LLC.
http://www.cyberacoustics.com/
(360) 823-4100
info@cyberacoustics.com

Denon Electronics
http://www.usa.denon.com/
(973) 396-0810
contactservice@denonnj.com

Digiana
82-2-2040-6211
general@digiana.com

Digital Age Products
http://www.digitalageproducts.com/
(888) 716-6395
info@digitalageproducts.com

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

Dynex
http://www.dynexproducts.com/
(800) 305-2204

Elecom Co., Ltd.
http://www.elecom.eu.com

Emerson Research/Radio
http://www.emersonradio.com
800-909-1240
internet@emersonradio.com

Geneva Lab
http://www.genevalab.com
1-877-GENEVA9
support@genevalab.com

Ignitek
http://www.ignitek.com/
(949) 660-0488
esupport@ignitek.com

iHome/SDI Technologies
http://www.ihomeaudio.com/
(800) 288-2792
ihainfo@ihomeaudio.com

iLive / DPI (HK) Ltd.
http://www.ilive.net/
(314) 621-2881
customerservice@ilive.net

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

iRock
http://www.myirock.com/
(847) 202-1900
info@fidinc.com

JBL
http://www.jbl.com/
(516) 255-4JBL

JVC (Victor Company of Japan)
http://www.jvc.com/
(800) 252-5722
http://www.jvc.com/support/support.
jsp?pageID=5

Klipsch
http://www.klipsch.com/
(800) KLIPSCH
support@klipsch.com

Logic3/SpectraVideo
http://www.logic3.com
support@logic3.com

Logiix
http://www.logiix.net/
http://www.logiix.net/contact.htm

Macally
http://www.macally.com/
(626) 338-8787
info@macally.com

Memorex Electronics/Memcorp USA
http://www.memorexelectronics.com
954-660-7100
http://www.memorexelectronics.com/
html/online_support_step4.php

Monitor Audio
http://www.monitoraudio.com/
+44 (0) 1268 740580
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Tiger Toys/Hasbro
http://www.tigertoys.com
800-844-3733

Tivoli
http://www.tivoliaudio.com/
(877) 297-9479
mail@tivoliaudio.com

Tunewear
http://www.tunewear.com/
info@tunewear.com

Stand & Mount 
Manufacturers

Atech Flash Technology (AFT)
http://www.atechflash.com
510-824-6868
sales@atechflash.com

Belkin
http://www.belkin.com/
(800) 223-5546 ex 2263
techsupp@belkin.com

BookEndz
http://www.bookendzdocks.com/
(847) 742-3566
sales@BookEndzDocks.com

BrightonNet Co.
http://www.brightonnet.co.jp/
81-3-5812-5735
export@brightonnet.co.jp

Bubble Design
http://www.bubbledesign.com/
(650) 988-9090
info@bubbledesign.com

Digital Lifestyle Outfitters (DLO)
http://www.dlo.com/
(800) 866-IPOD
info@dlo.com

Maxell
http://www.maxell-usa.com/
(800) 533-2836
techsupp@maxell.com

Onkyo Corporation
http://www.onkyo.com/
(201) 785-2600

Pacific Rim Technologies
http://www.pacrimtechnologies.
com/
(949) 481-2443
info@pacrimtechnologies.com

PodGear
http://www.podgear.net/
+44 (0) 1494 522 721
info@disruptivegroup.com

mStation
http://www.mstationaudio.com
800-213-7232

Mythix, Inc.
http://www.mythix-inc.com/
(888) 885-5858
info@mythix-inc.com

Numark Industries, LLC
http://numark.com/
(401) 658-3131
info@numark.com

Nyko
http://www.nyko.com/
(888) 444-NYKO
customersupport@nyko.com

Onkyo Corporation
http://www.onkyo.com/
(201) 785-2600

Oregon Scientific, Inc
www.oregonscientific.com
949-608-2848
customerrelations@oscientific.com

Pacific Rim Technologies
http://www.pacrimtechnologies.com/
(949) 481-2443
info@pacrimtechnologies.com

Phonic Corporation
http://www.phonic.com/
(813) 890-8872

PodGear
http://www.podgear.net/
+44 (0) 1494 522 721
info@disruptivegroup.com

PsiberAudio
http://www.psiberaudio.com/
(65) 6220-4240
andrew@psiberaudio.com

Rain Design, Inc.
http://www.raindesigninc.com
1 800 797 7321

Sharper Image
http://www.sharperimage.com/
(800) 344-5555
care@web.sharperimage.com

Sonance
http://www.sonance.com/
(800) 582-7777
customerservice@sonance.com

Sonic Impact Technologies
http://www.si-technologies.com
http://www.si-technologies.com/info/
contactus.html

PodShop, LLC
http://podshop.com/
info@podshop.com

Power Support (USA), Inc.
http://www.powersupportusa.com/
(818) 558-1645
CustomerService@PowerSupportUSA.
com

Pressure Drop, Inc.
http://pressuredropinc.com/
(541) 382-2197
products@pressuredropinc.com

Pro-Fit International, Inc.
http://www.pro-fit-intl.com/
(800) 388-0073
sales@pro-fit-intl.com

Proclip
http://www.proclipusa.com/
(800) 296-3212
support@proclipusa.com

Pyrim Technologies
http://www.pyrim.com/
(469) 366-4440
support@pyrim.com

Qortico
http://www.qortico.com/
info@qortico.com

Risse Racing Technology
http://www.risseracing.com/
(530) 246-8700
sales@risseracing.com

Speck Products
http://www.speckproducts.com/
(650) 463-8914
info@speckproducts.com

Strata Systems LC
http://www.ibikemount.com
http://www.ibikemount.com/contact.
htm

The PlasticSmith, Inc.
http://www.plasticsmith.com/
sales@plasticsmith.com

Thought Out
http://www.thoughtout.biz/
(203) 987-5452
info@thoughtout.biz

Westshore Craftworks, LLC.
http://www.westshorecraftworks.com/

Xitel
http://www.xitel.com
512-331-5799
nasales@xitel.com
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Video Display Manufacturers

Altec Lansing Technologies, Inc.
http://www.alteclansing.com/
(866) 570-5702
csupport@alteclansing.com

Icuiti Corporation
http://www.icuiti.com
(585) 359-7575
technical_support@icuiti.com

iLuv/jWIN Electronics
http://www.i-luv.com
866-807-5946

Memorex Electronics/Memcorp USA
http://www.memorexelectronics.com
954-660-7100

MicroOptical Corporation
http://www.microopticalcorp.com
(781) 326-8111
sales@microoptical.net

Sonic Impact Technologies
http://www.si-technologies.com
http://www.si-technologies.com/info/
contactus.html

ViewSonic
http://www.viewsonic.com
(800) 688-6688
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If you love the logo enough to buy corporate gift items that weren’t Apple-
designed but still look cool, the Apple Company Store is the place for you.

The Company Store is near 
the edge of Apple’s corporate 
headquarters at 1 Infinite Loop, 
Cupertino, California, and stocks 
a variety of items we’ve wanted 
to see in regular Apple Stores 
for years: Apple T-shirts, caps, 
mouse pads, and keychains. 
You’ll also find a number of 
items from normal Apple Stores, 
such as iPod and Mac hardware, 
software, and accessories, 
though this location is reputably 
slower to stock Apple’s new 
releases than others, and only 
open from Monday to Friday, 
10AM to 5:30pm. A full map is at 
www.apple.com/companystore/
directions.html. 

About the Store

iDrink
If you’ve been to a 

Starbucks any time 
in the last year, the 

design of these beverage 
containers won’t surprise you - 
the Fusion Water Bottle ($10) 
looks basically identical to the 
ones sold by the Seattle coffee 
company, and the White Travel 
Mug ($17) isn’t exactly novel, 
either, but fans of most Apple 
hardware will find either to 
be a great fit on a desk with a 
metallic Mac or Cinema Display; 
the logo doesn’t hurt.

It’s not really called the iPen, but this Black Twist 
Pen ($10) - one of several pens sold at Apple’s shop - 
has more in common with the styling of an iPhone 
than any other item at the Company Store. Brushed 
metal and chrome are mixed for most of its body; 
you twist a black hard rubber grip near the tip to 
reveal the ballpoint inside.

iPen

Coveted by iLounge’s 
non-California editors 

and the handfuls of 
other people who have seen 
friends wearing them, Apple’s 
“I Visited the Mothership” 
T-Shirt ($16) is at once a 
testament to geekiness and 
exclusivity - a trophy for those 
who make the journey all 
the way to Apple’s campus 
and want a way to prove as 

much. Other styles are also 
available; we’ve been hoping 
for similar shirts to appear in 
Apple Stores for a long time.

iShirt
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GPS devices - even expensive ones - can be 
frustrating. Not Harman Kardon’s Guide + Play 
($400), a totally portable unit with an intuitive 
touchscreen interface, super-current maps, 
and built-in music and video playback features. 
A speaker on the back does double-duty, 
interrupting music to offer voice navigation 
assistance. We can only hope Apple does GPS as 
well in a future-generation iPod or iPhone.

Sony PlayStation 3
with Sega Virtua Fighter 5

In all candor, we would never, ever have expected to feature 
Sony’s PlayStation 3 ($599) game console in any of our 

Guides. Unlike t’s radically overpriced, hemhorraging third-
party exclusives as a consequence, and from a company 

with monsterously bad judgment as of the last decade. But 
we have to give Sony credit for two things: PS3’s iTunes-like 

PlayStatiton Store is a cool way to buy cheap new games, 
and its six-month exclusive Virtua Fighter 5 from Sega ($60) 

is the rare Blu Ray Disc-based game worth the high price of 
admission. Stunning 3-D graphics finally make proper use 

of our HDTVs, and a wide roster of amazing martial artist 
characters keep the one-on-one fighting interesting for 

weeks on end. Since VF5’s coming by mid-year for the $200 
less expensive Xbox 360, consider that an option unless Sony 

drops its price and shows further signs of surviving.

Backstage. 
Our editors provide spotlight cool gadgets we’ve recently been checking 
out, and offer behind-the-scenes details on the creation of this Book.

Harman Kardon 
Guide + Play
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As much as we like video cameras, still cameras are our 
tools of choice for travel and business. If we had to pick 
a replacement for our current favorite point-and-shoot - 
Canon’s SD700IS - it would be the upcoming PowerShot 
SD850IS ($400, mid-June). Though its improvements 
over the stellar SD700IS are small - an unnecessarily 
larger 8-Megapixel sensor and face recognition for 
redeye reduction - its preservation of features like optical 
image stabilization, a large 2.5” rear LCD display, DIGIC-
aided color optimization, and a fast 4x zoom lens make 
it an ideal camera for day or nighttime shooting. The 
reasonable price doesn’t hurt, either.

Canon PowerShot SD850IS

Samsung SGH-D900
Okay, cell phones universally became boring 
after Apple introduced iPhone, but its pricing 
and uncertain overseas release date had our 
U.K. editor looking for other options. He went 
for Samsung’s SGH-D900 ($330), billed as 
the thinnest slide-open phone out there 
despite including a 2.2” screen, impressive 
3-Megapixel camera, integrated music player 
and around 7 hours of talk time. Quad-band 
GSM and EDGE support make it useful 
for both phone calls and data no 
matter where you might be using it. 

Consumer-priced high-definition video cameras 
have never looked as good as Canon’s HV20 ($1100), 
accurately dubbed “the monster” by the Japanese press. 
Combining true 1920x1080 recording with an optional 
24p cinema-style recording mode, HV20 has a flip-out 2.7” 
screen and direct HDMI video and audio output - all the 
features people have been clamoring for, in one compact 
device. MiniDV tapes enable you to store video until 
you’re ready to display it on your HDTV or import it into a 
video editing program such as Apple’s iMovie HD.

Canon HV20

Sony Bravia 
KDL-40XBR2
We’ve been lusting after the clear-framed KDL-40XBR2 
($2800) ever since we first saw it paired with an Apple 
TV. A true 1080p, 40” LCD television, the XBR2 is capable 
of swapping its grey bezel for white, black, red, blue, or 
brown alternatives, and has Sony’s typically excellent 
color and video quality. Three HDMI ports hide the only 
reason we’re not rushing to buy one: we’re holding out 
for the 2007 model with superior HDMI 1.3 support.
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Our Guides depend on great gear, software, 
people, and music. Here’s what made this Book.Behind the Book

The Free iPod Book 3.3 owes its life 
to Adobe Creative Suite 3 Design 
Standard ($1199), licenses for which 
were purchased on the day of the 
product’s release. During the month of 
the Book’s production, we had only a 
single crash in CS3’s superb InDesign 
application - it and Photoshop are 
perhaps the most stable and fastest 
versions we’ve ever used. Paired with 
our MacBooks and Cinema Displays, 
the Universal Binary versions of these 
programs are just wicked.

Software

Every iLounge Guide has musical 
inspiration - past ones, for instance, 
have been driven by bhangra, dance, 
or rap. This book’s themes were 
rock and chill. We discovered The 
Rapture’s Pieces of the People We 
Love - both the album and the superb 
same-named track, produced by 
Danger Mouse - during the project. 
The Beatles’ Love and Electric Light 
Orchestra’s All Over the World were 
key, while Röyksopp’s Melody A.M. 
and Groove Armada’s Best Of album 
provided much-needed calming vibes 
while we worked on layouts.

Music

Our Free iPod Books are assembled 
using Apple MacBook Pro notebook 
computers ($2500) equipped with 
Apple Cinema Displays. One of our 
two key workhorse machines is a 
2.0GHz Core Duo MacBook Pro, the 
other is a 2.3GHz Core 2 Duo model. 
Past Guides have been assembled with 
PowerMac G5 workstations, PowerBook 
G4 notebooks, and even a Power PC-
based Mac mini as a backup machine, 
but we’ve now switched entirely to 
Intel-based Macs for production. PCs 
are used only for testing of certain 
Windows-based applications.

Hardware

The Free iPod Book 3.3 was 
written primarily by Jeremy 
Horwitz with contributions 
from Jesse Hollington, Jerrod 
Hofferth, Bob Starrett, Larry 
Angell, and Christina Easton. 
It was designed primarily by 
Dennis Lloyd from layouts 
and photography by Jeremy 
Horwitz, and includes additional 
photographic and artistic 
contributions from numerous 
iLounge readers, as well as listed 
companies. Thank you to all 
the people who helped in the 
creation of this Book, especially 
our families, without whose 
support these Guides would not 
be possible.

People
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Power Support 
MacBook Docking Stand

Axio makes some great 
bags and cases. Even 
after testing gobs of 

other MacBook sleeves, 
Hardsleeve ($XX) still blows 

us away. The outer plastic 
comes in three colors - 

black, silver, and white -
each lined with padded 

neoprene. They zip closed, 
and absorb bumps.

Axio 
Hardsleeve

G-Technology G-Drive Series

Mounting a MacBook or Pro next to our monitors 
used to be a pain. Power Support’s Docking Stand 

for MacBook ($40) solved the problem 
with style. Made from 

matching 
aluminum and 
adjustable to 
your preferred 
width by screws, 
it keeps our 
MacBooks’
ports fully 
accessible.

BBP Bags
Hamptons
Photos don’t do justice to BBP’s 
Hamptons ($95). An ultra-
convenient top zipper lets you 
slip your laptop in or out in 

seconds, perfect for airport 
security and daily use. Better 

yet, padding and a dual-
purposed back strap take 
pressure off your spine, 
or converts into a regular 
shoulder strap. Awesome.

Altec Lansing 
FX6021

Our favorite computer 
speakers just happen to 

match the Cinema Display. 
Altec’s FX6021 ($250) has 
been mentioned in a past 
iLounge Guide, as its two 

satellite speakers (one’s 
shown) boast a total of 

12 drivers, with a massive 
subwoofer to add meaty 
bass. A breakout box and 

remote control adjust bass, 
treble, and volume.

Between our ever-expanding music, video, and photo libraries 
and the commensurately larger Guides we produce, extra hard 
disk space is a necessity. After testing and having problems 
with many competitors, we bought G-Technology’s 500GB 
G-Drive ($279), 750GB G-Drive Q ($519), and 1.5TB G-Raid 
($1199). The Mac-matching aluminum enclosures are quiet and 
cool, and the Q version connects to everything from USB to 
FW800 and eSATA.
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Great products need great pitchmen - hell, iPod sales didn’t 
take off until they hired those spooky shadow guys to dance. 
Zune needs a mascot who speaks to your core demographic, 
youthful non-conformists who want to get Social. Lucky you: 
Steven, the “Dell Dude,” is totally available, and his old slogans 
work just as well with Zune as they did to help millions of 
people experience the phenomenon that was Dell Computer. 

Hire an Awesome Mascot

Ever wonder why the Internet suddenly lit up with all sorts of 
aggressively anti-Apple, pro-Zune fanatics last year? When you 
can’t generate real buzz for your products, you pay people to 
start up blogs, and spam comments and forums on web sites 
related to your products. Microsoft doesn’t seem to need this tip: 
it already has the phony buzz down pat.

Pay People to Praise Zune
(Oh, Wait, You Already Do)

Bill. Steve. Robbie. You guys give lots of speeches - some funnier than 
others - and you always make a point to say what you’ve figured out that 
people really want. Like ads inserted into Media Center content. A way to 
bring the Windows OS into cars. And a mobile phone that lets you answer 
your doorbell. Why not build some of these ingenious ideas into a next-
generation Zune? Don’t forget MS-DOS support; we’re holding our breath.

Add Support for All Those Crazy 
Things You Say Customers Want

Problem: In an iPod world, no current celebrity - even a shill like Paris 
Hilton - wants to be associated with Zune. Solution: License the youthful 
likenesses of old celebrities, and create one-offs like the Young, Hip David 
Hasselhoff Limited Edition Zune (above). Typically, stars of yesteryear need 
the cash, and if you’re lucky, they might just have a huge library of Zune 
Marketplace-exclusive German-language songs that aren’t yet on iTunes.

The old “bundle a media 
player” with Windows 
strategy is a proven 
success - it actually 
worked so well during the 
1990s that, well, you got 
sued by the United States 
and the European Union. 
But everyone’s probably 
forgotten about that by 

now. Certainly no one would 
mind if you tossed Zunes into your 

Windows Vista boxes - in fact, you can put out a press release 
about how you’re doing it for the environment, solely to reduce 
your packaging. People seem to like hearing that.

Bundle It 
With 
Windows

CLOSING THE CURTAIN.
 Since Microsoft hasn’t given up on last year’s “iPod killer” yet, we wanted to
 offer a few friendly pointers on how it might revive Zune’s sagging fortunes.

Make Cool Licensed Zunes
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